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Manual created by Alexander Leemans
Most recent version of ExploreDTl is: v4.8.6.

This manual is showcasing the very basic tools of ExploreDTI. It is far from complete, but it's a start! Any
feedback is always welcome...

Q&A and discussion forum: https://groups.google.com/group/e _dti.
Notifications and updates: https://twitter.com/ExploreDTI.

ExploreDTI was released at the ISMRM 2009 meeting. The abstract can be found here. The reference is:

Leemans A, Jeurissen B, Sijbers J, Jones DK. “ExploreDTI: A graphical toolbox for processing, analyzing,
and visualizing diffusion MR data”. Proceedings of the 17th Scientific Meeting, International Society for
Magnetic Resonance in Medicine, Honolulu, USA, p. 3537, 2009.
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1. Installing / starting ExploreDTI

Standalone versions of ExploreDTI are available for Windows, Linux & Mac (only for 64 bit OS). With the
standalone executable, there is no need have Matlab installed.

If you *do* have Matlab (R2010a or later) installed, there is also a P-code version of ExploreDTI that runs
natively in Matlab and, therefore, in principal at least, can run on any platform (32 bit and 64 bit OS). At this
stage, source code of ExploreDTlI is not released.

It is recommended to install ExploreDTI on a computer with high-performance? specs: (i) multi-core CPU; (ii)
RAM > 16 GB; and (iii) dedicated graphics cards / GPU’s.

If you already tried to run the executable ‘MainExploreDTI' before having read this part of the manual, you
may have encountered the following error message (or something similar — MCR version may be different):

o o

Error @

Could not find wersion 8.2 of the MCR,
! . Atternpting to load mclicedd_3.d1L
Please install the correctwersion of the MCR,
Contact your vendor if you do not hawve an installer for the MCR,

Ok

Reading section B) below will clarify things...

A) Using ExploreDTI natively in Matlab

Put the ‘Source’ folder and the ‘MainExploreDTI.p’ file in your ‘Matlab path’ and type ‘MainExploreDT!I’ in the
command prompt (and press ‘enter’)... that should do it!

B) Installing & starting the standalone of ExploreDTI (no Matlab needed)...

Make sure your computer is up-to-date re java (e.g., http://www.java.com), graphics card drivers (e.g., for
Intel graphics cards, http://downloadcenter.intel.com), OpenGL libs (e.g., http://www.opengl.org/), etc.
Otherwise, you might get error messages or just weird bugs. Perhaps only perform these updates, if need
be.

The standalone version of ExploreDTI is currently being developed in Matlab 8.3.0.532 (R2014a). The
executable, “MainExploreDTI”, only works AFTER you installed the (free!) Matlab-Common-Runtime (MCR)
libs of that Matlab version — you can download the one for your OS of interest here (~ 600 MB):
http://www.ExploreDTI.com/matlab/64/MCR_R2014a win64 installer.zip (Windows — 64 bit)
http://www.ExploreDTI.com/matlab/64/MCR_R2014a_glnxa64 _installer.zip (Linux — 64 bit)
http://www.ExploreDTI.com/matlab/64/MCR_R2014a_maci64 _installer.zip (Mac — 64 bit)

To install the MCR libs file, simply follow the instructions. Note that MCR libraries from other Matlab versions
are probably not compatible with these standalone versions of ExploreDTI. Again, note that you do NOT
need a Matlab license to run ExploreDTI! For Linux/Mac, if you choose an installation directory for the MCR
that is different from the default one, you need to use this path in the “run_MainExploreDTI.sh” as well.

1 High-performance is defined here as: “Not getting annoyed by slow graphics rendering or insufficient RAM”.


http://www.java.com/
http://downloadcenter.intel.com/
http://www.opengl.org/
http://www.exploredti.com/matlab/64/MCR_R2014a_win64_installer.zip
http://www.exploredti.com/matlab/64/MCR_R2014a_glnxa64_installer.zip
http://www.exploredti.com/matlab/64/MCR_R2014a_maci64_installer.zip
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C) Running ExploreDTI ...

E.g. for Windows, after installing MCR libs — and perhaps the typically required Windows reboot — put the
executable file 'MainExploreDTl.exe' in a folder, such as “C:\ExploreDTI". Then, double-click the executable
'MainExploreDTl.exe' (the actual ExploreDTI program!). This might take several seconds (or even a minute
or two when executed for the first time), as it loads the required Matlab libs.

If things go well, for Windows, the screens below should appear — or at least something similar depending on
the exact version of ExploreDTI:

1) The command prompt appears first (read only): it will provide information about the progress of certain
calculations and reports ‘errors/bugs/crashes’ (btw, feedback of the latter is useful). If you get errors at
this stage, you might need to look at the ‘install’ sections above (or just consult the forum...).

& C\WorkiMatlsbWork\ ExploreDT]_SA\MainExploreDTLexe = | B

Starting ExploreDTI v4.8.3,. please wait...

Mote: no warranty supplied and
not approved for clinical use?

Starcting ExploreDTI w4.8.3, please wait...
HNote: no warranty supplied and
not approved for clinical use!
& Alexander Leemans

2) Then, a ‘splash-window’ should appear. If so, things are looking good!

P
& ExploreDTI 4.8.3 - © Alexander Leemans =1 X

Developed at Vision Lab, CUBRIC, and
Image Sciences Institute

Vision Lab

No warranty supplied and not approved for clinical usel
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3) Finally, the actual ExploreDTI program should start up. If you see the window below, you are ready to
go!

"
&) ExploreDTI v4.8.3 - © Alexander Leemans | s S
Data Imagemap Axis Draw Calculate Color Show Hide Delete Settings Palettes  Animations Miscellanea Help Plugins  Calculate DTI *.mat file

Most menu items are disabled at start-up to prevent you from accidentally crashing ExploreDTI. Exceptions
are ‘Data’, ‘Settings’, ‘Miscellanea’, ‘Plugins’, ‘Help’, and 'Calculate DTI *.mat file' (if you run ExploreDTI in
Matlab, the other menu items are not relevant, as they are built-in by Matlab itself). Note that menu item
names may change in future releases. Also, the version number (here, v4.8.3) might be different.

If you are eager to try things out, download the example DTI *.mat file and load it via the ‘Data’ menu item:
http://www.exploredti.com/exampledataset.htm. Tip: immediately after loading, the menu item ‘Palettes’
becomes available. Useful ones to start messing about are the ‘Axis’ and ‘Draw’ palettes.

If you want to use your own data, see the next section.


http://www.exploredti.com/exampledataset.htm
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2. Converting your DWI’s to an “ExploreDTI file” (*.mat)

This section describes how you can convert your raw diffusion data to the format of ExploreDTI. The end-
result of this conversion step is a DTl *.mat file that contains pre-processed data, such as the diffusion
tensor, eigenvalues, eigenvectors, mean diffusivity, fractional anisotropy, the DWIs, B-matrix, gradient
directions, etc.

Background

Most likely, you conducted a diffusion MRI experiment (DTI, DKI, HARDI, DSI, ...), which has resulted in a
folder (perhaps with sub-folders) of (un-)sorted dicom files. This type of format is not really practical
(typically, each 2D image slice has its own file), so it usually converted to more manageable formats (where
all slices/volumes are put in a single file), such as *.par/*.rec (Philips-specific), *.nii(.gz) (NIFTI), *.hdr/*.img
(analyze), etc.

As an example, consider a typical diffusion MRI acquisition with 30 diffusion weighted images (DWI's) and 3
non-DWTI’s, i.e., the “b = 0 s/mm?” (or b0 in short) images, with each 3D image consisting of 60 slices.
Compare the speed of loading 1980 (= [30 + 3] x 60) separate dicom images vs. a single 4D *.nii file... it
*does* make a difference! Mainly due to this efficiency issue, | opted for *.nii as the standard input file format
to start processing with ExploreDTI.

All DWIs (including the b0 images) are assumed to be included in the 4D *.nii file with the b0 images at the
beginning. If the b0 images are not at the beginning, there is a plugin ‘Plugins’ - ‘Shuffle/select 3D
volume(s) in 4D *.nii file(s)’ that you can use reorder the b0 images to the beginning. Alternatively, you can
use the ‘Sort DWI *.nii file(s) wrt b-values’ plugin assuming you have a b-matrix *.txt file (see below).

Converting data (dicom/hdr-img/2dseq/par-rec) to NIFTI (*.nii)

In my opinion, a great tool to convert dicom files to NIFTI files is Chris Rorden’s “dcm2nii” tool:
http://www.cabiatl.com/mricro/mricron/dcm2nii.html. | have included this tool and MRIcron itself (allows one
to view *.nii files), version 15 October 2008, as plugins into ExploreDTI (see menu item ‘Plugins’ - ‘Convert
... > ‘Dicom folder(s) to *.nii files’). Similar for the other data formats (img/hdr, par/rec, ‘2dseq’), there are
conversion tools to get the 4D *.nii data. In any case, the end result should be a 4D *.nii file. Important — as
always — check the *.nii file for left/right flipping!

If you are familiar with Matlab, you may want to use the NIFTI tools developed by Jimmy Shen:
http://www.mathworks.nl/matlabcentral/fileexchange/8797. This might be useful when you do not have dicom
files, but some other format. Read the data into Matlab and then export them to a 4D *.nii file with these
tools.

The B-matrix

To convert your *.nii data to an ExploreDTI ‘DTl *.mat file’, you also need the B-matrix (*or* the gradient
directions and the b-value). | will spare you the details on how to derive the B-matrix — an example (B-matrix
with 1 b0 and a b-value of 1000 s/mm?) is given below (left), derived from the 12 gradient directions, shown
on the right.

| Example B-matrix.txt - Notepad == [EcR(Fx7)| | Gradients.bet - Notepad =N EoR =5
File Edit Format View Help File Edit Format View Help

0. 00000000 0. 00000000 0. 00000000 0.00000000 0. 00000000 0. 00000000 - 0.9024 0.0361  -0.4293
814.40765652 65.18967083 -774.87732493 1.30453500 -31.01272277 184.31643658 -0.001& 0.4392  -0.8985

0.00257270 -1.40905695 2.88226527 192.93393198 -789.30347186  807.27112684 0.4070 0.9135 0.0005
165.65429279 743.59254310 0.43561773 834.46353974 0.97770511 0.00028638 0.8735 0.4867 0.0137
763.00556381 850.19364463 23.88218985 236. 83616072 13.30559500 0.18687904 -0.0305 0.8898 -0.4556

0.93302274 -54.35749941 27.83245736 791.71107337 -810.75343524  207.56345176 0.4649 0.0124  -0.8853
216.12404514 11.53945569 -823.18086836 0.15403080 -21.97594246 783. 84006461 0.8842 0.0437 0.4650
781.83932364 77.30926760 822.25278610 1.91110970 40.65270111 216.18880754 0.0380 -0.4543  -0.8901

1.44072689 -34.49089697 -67. 56969386 206.42739109 808.80677780 792.25000176 -0.4864 0.8737 -0.0173
236.61207599 -B849.95242726 16.86724813 763.29486310 -30.29506933 0. 30060180 0.9132 -0.4069 0.0220
833.86972410 -743.17633635 40.12584058 165. 58673704 -17.88083578 0.48271422 ~0.0488 0.8974 0.4387

2.37890783 -87.53764712 -42.79343654 805. 28967760 787.34381956 192. 44947111 _0.4285 -0.0275 -0.9032
183.64522152 23.57926143 774.12862588 0.75686909 49.69740324 815. 80550320

b



http://www.cabiatl.com/mricro/mricron/dcm2nii.html
http://www.mathworks.nl/matlabcentral/fileexchange/8797

p. 6

The nice thing about “dcm2nii” (see previous section) is that it can produce “*.bval’ and “*.bvec” files (see

below).
Examplebval - Motepad = =[]
File Edit Format View Help
0 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 -
[
Example.bvec - Notepad (=x|HoR <)

File Edit Format View Help

0 0.902445375919342 -0.00160396262072027 0.407006502151489 0.873501896858215 -0.0305454200446907 0.46489143371582 0. .

0 0.0361183471977711 0.439242452383041 0.9124B89758968353 0.486658155918121 0.889781475067139 0.0124109145253897

0 -0.429320901632309 -0.89848268032074 0.000535148370545357 0.013670370914042 -0.455591320991516 -0.885347425937653

Fl T

From these “*.bval” and “*.bvec” files, the B-matrix *.txt file can be calculated (see menu item ‘Plugins’ >

‘Convert ...” > “*.bval/*.bvec to B-matrix *.txt file(s)’).

Making the *.mat file for ExploreDTI

OK — now the last step! By now, you should have a 4D *.nii file and its corresponding B-matrix (or gradient)
* txt file (as described/shown above). Now you can use the 'Convert raw data to DTI *.mat' tool (see below)
to create the DTI *.mat file, which can then be loaded into ExploreDTI. You should *NOT* try to run the
‘Custom-made data conversion tools’ from this same menu item, as they are custom-made and, therefore,

will *NOT* be suited for your data - crashes & incorrectly converted data are not excluded then!

Plugins | Calculate DTI*.mat file

Convert raw data to 'DTI *.mat’

Custerm-made data conversion toaols »

The screen below pops up with detailed info given when you go ‘mouse-over’ on the yellow text:

\/ ExploreDTl's data converter to create D

I

Format diffusion weighted data

4

Permute spatial dimensions

Flip spatial erientations

= =
T |
allAa
=~
n||n
4

Perform visual data check

Diffusion tensor estimation Linear (high speed - low accu...

Format diffusion information Text file (*.txt)

Background masking appreach Automatic

Permute gradient components

The gradient components x, y, and z should correspond
with the coordinate frame of the spatial dimensions

of the data. Here, you can swap the component. This
will change the 'color-encoding'. The most widely
used convention is: AP = green; RL = red; IS = blue.

b-value in units simm*2

Voxel size [AP RL 18] {in mm)

Number of non-DW images
Number of DW images

Matrix size [AP RL I5]

Start converting to D




p. 7

One thing you should definitely check is: *MAKE SURE LEFT-RIGTH ORIENTATION IS NOT FLIPPED*!
Btw, | use the radiological convention, i.e. left and right in the image represent right and left in the data set,
respectively, that is, if you look at it in a 2D axial view with default settings. If you are not sure, just ‘rotate’
the image, so you can unambiguously ‘see’ the 3D nature of the data/object. My advice: always attach a
marker on the right side of the subject (e.g., a vitamin pill) — you will never switch sides ever again ;-)! And
secondly, use the plugin “Flip/permute dimensions in 3D/4D *.nii file(s)” to make all your nifti files —
not just the DWIs, but also any other data such as T1, T2, etc. — “ExploreDTI compatible” to begin
with... this will avoid unexpected axis flips (& permutations) in any following analyses.

After converting to *.mat, check whether you used the widely used color-convention for your data (left-right:
red, top-bottom: blue, and front-back: green). So, if need be, change 'Permute gradient components' from ‘x
y Z’ to, for instance, 'y X Z' to interchange red and green)!

Furthermore, you might need to change the sign of your gradient components, which is obviously very
relevant for tractography (to do this, change 'Flip sign of gradient components'). For example, compare the
images below (‘Draw ROI’ = ‘Draw Glyphs’) — do you see the difference (the z-component was flipped: 'x y
zZ'vs.'xy-z)?

Perform this check for the other views as well — there may be multiple components that need to be changed
simultaneously (see below for another example: the x-component was flipped: 'xy z' vs. -x y z)!

If you have problems converting your raw data, get help from the forum (upload your data). Otherwise, there
are only a limited number of combinations possible... good luck!
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3. Loading a DTl data set

Since ExploreDTI was developed originally only for DTI (hence the name — the other diffusion approaches
came later), the only type of data you can load at start-up is a ‘DTI *.mat file’ (Matlab format). This *.mat file
contains a set of variables with a fixed nomenclature (otherwise, ExploreDTI will not load the data). An
example data set can be found on www.ExploreDTI.com.

b ExploreDTIv4.8.1 - © Alexander Leemans

Image map Axis Draw Calculate Color  Show Hi
Load DTI (*.mat) Ctrl+L
Load volume (*.mat,*.nii)

Load fiber tracts (*.mat)

Load single ROI (*.mat)

Load multiple ROI (*.mat)

Load C5D FOD (*.mat,*.nii)

Save fiber tracts (*.mat,*.nii,*.txt)
Save mask of ROz (*.mat, *.nii}
Save single ROI (*.mat)

Save multiple ROI (*.mat)

export current volume as RGB (*.mat)

If you have loaded a DTI *.mat file correctly, you should be able to see the following screen (with the menu
items enabled now):

b ExploreDTI v4.8.1 - © Alexander Leemans C:

Y ole.ma 1L
Data Imagemap Awis Draw Calculate Color Show Hide Delete Settings Palettes  Animations Miscellanea Help  Plugins  Calculate DTI *.mat file
= = N =

Notice that the figure name contains the full path (here: ‘C:\ExploreDTI\DTI_Example.mat’) of the DTI data
set that is currently loaded (if you do not see anything, adjust masking or OpenGL setting: see Q&A forum).


http://www.exploredti.com/
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4. Palettes and multiple windows

Using the tools in ExploreDTI from the menu bar items can be a pain (e.g., when computationally expensive
renderings are shown in the main axis object, the ‘menu item refreshing’ becomes extremely slow). To
circumvent this issue, ‘palettes’ can be prompted containing a group of commands that can be accessed
directly. When running ExploreDTI in Matlab (using the p-code version), these ‘palettes’ are ‘docked’
automatically in the figure window and can be placed in any way you want. The screenshots below will clarify
this. | suggest to use these ‘palettes’ as much as possible — you will appreciate the benefits. As an example,
if you are running ExploreDTI in Matlab, do the following (after loading a data set):

44 Figures - ExploreDTI v4.8.1 - © Alexander Leemans C:\ExploreDTI\DTI Example.ma

il =N

Cancel

P roures]
Data Imagemap Axis Draw Calculate Color Show Hide Delete Settings Palettes Animations Miscellanea Debug Desktop Window Help  Plugins  Calculate DTI *.mat file

| e O [EnN=R=Nal

ExploreDTIv4.8.1 - € Alexander Leerans  C:\ExploreDTI\DTI_Example.mat

Then click ‘Palettes’ > ‘Axis’ and ‘Draw’, and then delete (click the ‘cross’) the empty window, so three
windows remain (see below).
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Data Imagemap Axis Draw Calculste Color Show Hide Delete Settings Palettes Animations Miscellanea Debug Desktop Window Help  Plugins  Calculate DTI *.mat file A

NG 8O BEoee0O

Axis Tools O 2 X  ExploreDTIv48.1 - © Alexander Leemans C:\ExploreDTNDTI Example.mat
M Reverse view M Cross hairs

w [Zvew ]
XPlane
® Orthographic @ Perspective

® Zoom ® Move HV @® Move FIB
© Orbit @ Orbit Light

Toggle Light

Draw Tools 02 x

ROl © Draw @ Delete All

e O s N ==

GLYPH: PDV (line) ~ All
Draw glyphs Delete glyphs

RacT.

Coler-encoding Tract shape
Lines

Render guality Sub-sampling

Calculate tracts Analyse tracts

Transparency Hyper width

opsve [ [cowmcerar B
M Hyper tube mode

ExploreDTI w4 8.1 - @ Alexander Leema... x| Axis Tools x| Draw Tools %

You can continue to do this with other ‘palettes’ as well - they will appear in the menu bar at the bottom (or
left/top/...) in a new ‘tab’ — click such a ‘tab’ to make it active and drag it to a field of your choice.

Right click on a window header if you want to further subdivide the windows (and incorporate other
‘palettes’):

I XPlane
©® Orthographic @ Perspective
® Zoom @® Move HV @ Move FIB
© Orbit @ Orbit Light

Toggle Light

Draw Toals = X
O Maximize Draw Tools

2 Undock Draw Tools

X Close Draw Tools

H Top/Bottom Tile

PDV (line) [T] Left/Right Tile
Draw glyphs Delete glyphs

TRACT: [[Detete | man

Color-encoding Tract shape

Render quality Sub-sampling

Calculate tracts Analyse tracts

Transparency Hyper width

oswe [ [cUncorsiy B
B Hyper tube mode
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For the standalone versions, however, these ‘docking’ tools are not available anymore (it did work for
releases R2009a and older — Matlab is going to look into it to see whether they will make it available again).
As a result, all palettes are separate windows, which cannot be docked (see below)...

& Ais Tools [E=1 =l |

M Reverse view [l Cross hairs

XPlane
© Orthographic @ Perspective

@ Zoom @ Move HV @ Move FiB
© Orbit @ Orbit Light

& Draw Tools =R

ROL © Draw @ Delete H Al

[ ] [ ] =]

Draw glyphs Delete glyphs

TRACT: HAl

Color-encoding Tract shape

Render quality Sub-sampling

Calculate tracts Analyse tracts

Transparency Hyper width

e [ [cUncoramy B
H Hyper tube mode

You will notice that the ‘Main Window’ (the one that contains the menu items) is ‘set active’ after any ‘click’
on any of the ‘palettes’ (is only useful when running it in Matlab using the docking tools). Just use a
configuration like the one above where the windows do not overlap — otherwise, it can be confusing.
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5. Data quality assessment

Quality assessment of DW images can be very labour-intensive. One approach to look at your 4D data is by
‘looping’ it. Do the following: 1) Load a DTI data set; 2) Set ‘Image map’ to DWIs. The resulting display might
look weird, since the intensity range is by default set to [0 1000] — it represents the (first) non-DW image; 3)
Now, ‘Palettes’ in the menu bar will allow you to open the ‘QA DWIs’ tools; 4) Click ‘Set auto value’ to set the
intensity range for that image.

Settings Animations  Miscellanea  Help

Axis
Draw
PASTA
QA DWIs

QA Volume

© Orthographic @ Perspective

@® Zoom @® Move HIV @ Move FIB
© Orbit @ Orbit Light

& DWI QA tools [=o[=] = |

Colormap | gray

M Loop

Set auto value

You can do several things now (see below): (1) use the image intensity sliders (‘Min val’ and ‘Max val’) to
adjust the intensity range. (2) Activate ‘loop’. Make sure there are multiple numbers indicated in the ‘Volume
range’, for instance ‘23:50’ (i.e., [23 24 25 ... 48 49 50]) or 23 50’ (notice the difference!?). Note that during
the looping, you cannot use the image intensity sliders (‘Min val’ and ‘Max val’). (3) select the other ‘Feature’:
‘Residuals’ (i.e., the absolute residual values to the tensor fit).
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Another quick semi-qualitative check is to look at the average residuals per DWI or across the DWIs for each
voxel (‘Show data quality summary’ — see below):

edian + ig-range)
s Animations Help  Plugins  Calculate DTI *.mat file

Make figure

Change working directory I

Change background color
Show data quality surmmary

Overlay tract visitation map ~ »

Fuse CV with FEFA
Fuse CV with MNI label
View CV in multi-slice

Surface render mask (3D *.nii)

Help Calculate DTI *.mat file

Motion/Distortion Correction (+ MNI)
Transform (affine) DTI data (*.mat)

Whole brain tractography 3
3D *.nii 2 3D *.nii

Export stuff to *.nii files

Flip left-right orientation of DTI *.mat file
Generate synthetic diffusion MRI data 3
Erain segmentation (BET)

Reorder non-DWI's in 4D *.nii to beginning
Resample 30/4D *.nii file(s)

Shuffle/select 3D volume(s) in 4D *.nii file(s)
Get precisions (wild bootstrap) of DTI *.mat
Check motion/distortion correction

Check outlier profiles

Open 'MRIcroN' (© Chris Rorden) DW image DW image

Crop size of *.nii file

These tools are just useful from a qualitative point of view (e.g., to give feedback to the MR physicist in the
event of artifacts). In practice, the robust diffusion (& kurtosis!) tensor estimation approach (i.e., ‘REKINDLE’
— the default approach in ExploreDTI during correction for subject motion, eddy current distortions, ect.) will
have taken this into account!


http://www.ncbi.nlm.nih.gov/pubmed/24687400
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6. Drawing ROls

Drawing an ROI requires you to ‘uncheck’ the ‘image planes’ on which you are not going to draw this ROI (it
will give you an annoying warning pop-up, otherwise).

To actually draw an ROI (see below), first click the ‘SEED’ (or ‘AND’ / ‘NOT’) button and then ‘left-click’ each
time to generate a point (notice that | have used the ‘Zoom’ and ‘Move H/V’ buttons to enlarge the slice to
the region of interest). ‘Right-click’ to close the ROI (don’t do anything else during this procedure or
ExploreDTI will crash).

& s Tools E=EN R

W Reverse view [l Cross hairs

M XPlane
@ Orthographic @ Perspective

@® Zoom © Move HV @® Move FiB
@ Orbit @ Orbit Light

& Draw Tools lsl@] = |

ROI: © Draw @ Delete E Al
o

[<1R (. H PDV (line) W E Al
Draw glyphs Delete glyphs

Coler-encoding Tract shape

Lines

Render quality Sub-sampling

- -

Caleculate tracts Analyse tracts

Transparency Hyper width

e [ (COmcerann B
W Hyper tube mode

Note that you can save, load, hide, show, and delete single/multiple ROIs. See, for instance, below (menu
item ‘Data’ - ‘Save single ROI (*.mat)’):

& ExploreDTl v4.5.1 - © Alexander Leemans C\ExploreDTN\DTL Example.ma
Imagemap Axis Draw Calculate Color Show Hide Delete Settings  Palettes  Animations
Load DTI (*.mat) Ctrl+L

Load volume (*.mat,*.nii)

Load fiber tracts (*.mat)

Load single ROI (".mat)

Load multiple ROT (*.mat)

Load €S0 FOD (*.mat,*.nii)

Save fiber tracts (*.mat,*.nii, *.tut)
Save mask of ROIs (*.mat,*.nii)
Save single ROI (*.mat)

Save multiple ROI (*.mat)

export current velume as RGB (*.mat)
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7. Quantitative ROI analysis

Once you have drawn one or more 2D ROIs (see example below), you can extract DTI related parameters,
such as the FA, MD, and the eigenvalues, which may be useful for quantitative analyses.

b/ ExploreDTI v4.8.1 - © Alexander Leemans Ci\ExploreDTIDTI_Example.ma
Color Show Hide Delete Seitings Palettes Animations Miscellonea  Help  Plugins  Calculate DTI*mat file
Tracts
Analyze Tracts from ROI's
Analyze Tracts from folder of masks

Analyze Tracts from Atlas labels

Descriptive Statistics

Brain context

After you click ‘Calculate’ > ‘ROI' (see above), a popup appears (see below) asking you to export the
statistics to a simple text file (so afterwards, you can import the numbers into SPSS, Excel, or any other
program you want to use for further statistical analyses...).

,
i)

@ Do you alzo want to save output to a txt-file?

Finally, a popup window appears with the relevant numbers in it (see below).

ROl statistics

The corresponding text file output looks as follows (I hope you understand — from comparing with the image
above — what each number represents ;-):

Edit Format View Help
. 78486554 0.14041212 . 02308361 . 73869831 . 83103276 . 83258456 . 76193139 . 86492459

. 00089634 . 00015742 . 00002588 . 00084458 . 00094810 . 00087361 . 00078093 . 00097482
. 00017868 . 00002937 . 00190042 . 00201791 . 00193389 . 00184477 . 00206831

0

. 00195916 0
. 00041484 0.00024933 . 00004099 . 00033287 . 00049682 . 00034819 . 00028005 . 00050469

0

. 00031500
. 00000000

. 00019846 . 00003263 . 00024975 . 00038026 . 00025300 . 00020061 . 00037583
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8. Tractography

DTI (Basser et al, MRM 44:625-632, 2000) and CSD (Jeurissen B. et al, HBM 32:461-479, 2011) based
tractography algorithms have been implemented. By default, the CSD approach implemented in ExploreDTI
uses recursive calibration of the response function (Tax C.M.W. et al, Neurolmage 86:67-80, 2014).

Although one could draw a seed region and then perform tractography from that seed region, | would
suggest to do ‘whole brain tractography’ instead and then use the ‘analyze’ functionality to extract fiber tract
pathways from ROls, as defined by ‘SEEDs’ (equivalent to ‘OR’ gate then), ‘ANDs’, and ‘NOTs’. This
reduces the user-bias of SEED ROI definition.

The best way to explain the above in detail is by giving an example: let us extract the ‘arcuate fasciculus’ (or
at least, the reconstructed pathways that may represent that WM bundle) and calculate the average FA, MD,
etc. along that pathway.

A) Perform ‘whole brain tractography’ (that is, using a deterministic streamline approach, based on the DTI
model). No need to load a DTI *.mat-file yet — just start ExploreDTI and go to ‘Plugins’ (see below):

nea Help Calculate DTI *.mat file ‘

Correct for subject motion 8 EC/EPI distortions

Whaole brain tractography 3 DTI
3D *.nii 2 3D *.nii CsD
Export stuff to *.nii files

You can do this for multiple data sets as well (see below, by choosing a folder of DTI *.mat files), but for now,
let us choose a single DTI data set.

' E ™y
&) Deterministic streamline tract...El_lﬂ

Seedpoeint Resolution (in mm)
222

Seed FA threshold
0.2

FA tracking threshold range (limits: [0 1])
02 1

WD tracking thresheld range (limits: [0 realmax]}
0 Inf

Linear geometry tracking threshold range (limits: [0 1]}
01

Planar geometry tracking threshold range (limits: [0 1]}
01

Spherical Geometry tracking threshold range (limits: [0 1])
01

Fiber Length Range (in mm}
50 500

Angle threshold (in degree)
30

”
° Whole brain tractography & L= =
Step size

1
For..? . . )
Interpolation method (NM: 0; Linear: 1; Cubic: 2)

1

| Single DTl data set (default}§| ’ Kultiple DT data sets

Select a DTI *.mat file and save the tracts to a *.mat file, as shown below:
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5|
& Sclect a DTI *.mat file.. e @ Save tracts as ..
Look in Input - «@crE- Savein Whole_brain | e ®EckEr
= Name - = Mame : Date modified Type
) _ .
ke #7 Data.mat Recert Flaces Mo items match your search.
Recert Places
Desktop Desktop
L
el -
Libraries Libraries
Computer Corr!p‘,mar
O 3
w a
Metworkc Networle
1 I b
« I 3
File name: ‘Data.mat j Open I Filz name: ‘Data?TradstT\ mat j Save
Files of type [Matizb (*mat) =] Cancd | Save as type [Mat Files (*mat) ~| Cancel
- J

Then the calculations start:

o Da not close waitbar: unexpected errors may occur!

Performing whole brain tractography...

Depending on your computer ‘specs’ it will take around 1 to 10 minutes (that is, for the default values above).

B) Load the tracts (after you have loaded the corresponding DTI *.mat file).

(W cclorebTI V481

Imagemap Axis  Draw Calculate Color Show Hide Delete Settings  Palettes  Animati

Load DTI (*.mat) Ctrl+L
Load volume (*.mat, *.nii}

Load fiber tracts (*.mat)

Load single ROI (*.mat)

Load multiple ROI (*.mat)

Load CSD FOD (*.mat,*.nii)

Save fiber tracts (*.mat,”.nii," bt

Save mask of ROIs (*.mat, *.nii)

Save single ROI (*.mat)

Save multiple ROI (*.mat)

export current volume as RGB (".mat)

Notice that this eats away your memory (3 GB is no exception — depending mainly on step size and seed

resolution)...

C) Placing ROIs to select a structure of interest. Draw ‘AND’ gates that define regions that would intersect
the “arcuate fasciculus”. You might need to draw ‘NOT’ gates to omit fiber tracts that are not of interest.
Then, click ‘Analyse tracts’ and click ‘Draw’. In this example, | used ‘Tubes’ as ‘Tract representations’ and
clicked ‘Toggle Light’ to give a 3D feel to it. To increase render speed, I've set ‘Sub-sampling’ to ‘4’.
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dsTools ElE] = I - O AR TIDTL Exemple ma
Data | Imagemap Axis Draw Calculate Color Show Hide Delete Settings Palettes Animations Miscellanea Help Plugins Calculate DTI*mat file

[ Show | MIReverseview M Cross hairs

XPlane | |

Orthographic @ Perspective

@ Move HV ® Move F/IB
@ Orbit Light

Toggle Light

-aw Tools =8| & |

© Draw @ Delete Al

[see0 |

LYPH: PDV (line) i Al
Delete glyphs

Draw Al

Color-encoding Tract shape

L
| Tubes '

Sub-sampling

14

Analyse tracts

Hyper width

CU (Uncertainty) H
B Hyper tube mode

Similar to the ROI analysis, you can calculate the stats of fiber tract structures (note that you can also save,
load, hide, etc. tracts). | *recommend* saving the end-result as a ‘tracts *.mat file’, as there is a plugin tool
that can convert an entire set of such tract *.mat files to a *.txt file (see ‘Plugins’ > ‘Convert’ > ‘Info of tract
*.mat file(s) to *.txt’), which contains the corresponding summary statistics.
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9. Tract segment analysis

Assume you want to analyse a particular segment of a fiber tract bundle, such as shown below. Here, for
instance, we are only interested in a particular segment of these “corticospinal” tracts as outlined by the two
AND ROls. To extract this part of the tracts, go to settings first and check 'segment only' (see below). When
checked, clicking 'analyse' will generate a pop-up to save the tract segment (uncheck it afterwards!).

e Palettes  Animations Miscellanea Debug

Tractography 3
HARDI » .eemans F\Demo_data\.

»

Glyphs 3

Image Map 3

Clustering 3

Color map 3

Brain context

Analyze M ¥ Segment only
Axis view » Splitter tool

Width ROL/marker
Probability atlas label
RESTORE approach 3
DKl 3
Automated masking

Atlas based tractography *

»

Use parallel computation

Define the ‘Temnp' folder

SM/EC/EPI correction 3
v Clean up PIS'
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The segmented tracts can then be loaded into ExploreDTI (see below):

From this segment, measures of interest (FA, MD, etc.) can be calculated as outlined before. A more general
approach to select ‘tract segments’ of interest is the ‘splitter’ tool, which uses the SEED (= OR) gates to ‘split’
the tracts at those positions. The tracts that have been split are then saved. Once reloaded, use
‘AND’/'SEED’ gates to select the segments of interest:

Palettes  Animations  Miscellanea  Debug

Tractography 3

HARDI b .eemans F\Demo_data\s
Glyphs k

Image Map 3 | - | “ 1
Clustering 3

Color map 3 - -
Brain context

Analyze k Segment only

Axis view » v | Splitter tool

Width RO marker
Probability atlas label
RESTORE approach 3
DKI 3
Automated masking
Atlas based tractography »
Use parallel computation
Define the 'Temp' folder
SM/EC/EPI correction 3
v Clean up 'PIS'

-
& Save split tracts - as defined by SEED ROI(s) - as .. ot
Savein: 5_BExample_Tractography j I‘j( Ei-
= MName =
i Input
Recent Places npy
Output
Desktop
it
Libraries
Computer
i
.
Metwork
4 n 2

File name: |T|ads_sp|i‘t.rnat j Save |

Save astype: |MAT—fiIes (" mat) ﬂ Cancel
Analyse tracts I |

-




After saving the ‘split’ tracts, load them:

0 Select tract data... lﬁ]
Look in: 5_BExample_Tractography j I‘j‘ '
= Mame =
.‘;_.r"‘ I t
Recent Places ned
Output
[ % Tracts_split.mat
Desktop
Libraries
Computer
@
Network
4 114 3
File name: |T|acts_spl'rt.mat j Open |
Files of type: |Mat Files {*.mat) j Cancel

Draw an ‘AND’ (green ROI) to select the segment of interest:

Analyse tracts

Hyper width
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Finally, click ‘Draw’ tracts — only the selected segment will remain:
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10. Correcting for subject motion & eddy current induced
geometric distortions

The relevant reference for this tool is “Leemans A. and Jones D.K., Magnetic Resonance in Medicine
61(6):1336-1349, 2009 (http://www.ncbi.nim.nih.gov/pubmed/19319973). The tool to correct for subject
motion & eddy current induced geometric distortions can be found in: ‘Plugins’ = ‘Correct for subject motion
& EC/EPI distortions’. See the menu item ‘Settings’ - ‘SM/EC/EPI correction’ for more details. | also
recommend using multi-core support for this tool (that is, if you have this Matlab toolbox installed): see ‘Use
parallel computation’ in the ‘Settings’. By default, the EPI correction step is omitted (see Section 11).

The output is again a DTl *.mat file, but then with the (default) extension * MD_C native.mat’. See the
before/after examples below:

Before correction After correction

Before correction After correction



http://www.ncbi.nlm.nih.gov/pubmed/19319973
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11. Correcting for EPIl/susceptibility distortions

There are several ways to (try to) correct for these deformations. The approach | implemented is based on
the work of Irfanoglu et al (http://www.ncbi.nlm.nih.gov/pubmed/22401760) and is integrated with the “subject
motion / eddy current distortions” correction tool. In this way, all corrections (SM/EC/EPI) can be performed
in one interpolation step (to minimize blurring effects). In summary, if you have an ‘undistorted’ modality
(T1,T2,...), you can use it to unwarp the deformations that are present in your diffusion data:

ete Palettes  Animations  Miscellanea Debug Desktop Window Help  Plugins  Calculate DTI *.mat file
Tractography
HARDI

-EEMAans

Glyphs

3
3
3
Image Map 3
Clustering »
Color map 3
Brain context

Analyze 4
Axis view 3
Width ROL/marker
Probability atlas label
RESTORE approach 3
DKI 3
Automated masking

Atlas based tractography »
Use parallel computation

Define the ‘Temp' folder

SM/EC/EPI correction » Tensor estimation procedure »
v Clean up 'PIS' Masking stuff »
Also register to other data? 4 Mo thanks (stay in native space)
Registration details for SM/EC correction » yes, to a single data set (rigid) ...
Set file name suffix 3 yes, to associated data sets (rigid] ...

v Yes, to do the EPI correction (non-rigid) ...

Export parameter file ...
Define image type for registration ¥ v Non-DWI

Registration details 3 FA
Avg(DWIs)

After ‘checking’ > ‘Yes, to do the EPI correction (non-rigid)’, a popup will appear asking you to fill in the
suffix of the file that will be used to do the correction. Example: if the DTI file is called “Data_set M.mat”
(below, left), then name the T1 file “Data_set_M_T1.nii” (below, right). For a T2, | suggest to use ‘Non-DW/I’
as the choice for ‘Define image type for registration’, for a T1, you could also try ‘Avg(DWIs)’ or ‘FA’. Masking
the T1 (or T2 etc.) data (‘zero’ value as background) increases the performance (note: scalp may still be
present as shown below).

“Data_set_M.mat” (uncorrected) T1 data set: “Data_set M_T1.nii”
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Important to know: the diffusion data will be resampled to the space of the ‘undistorted’ modality... you may
want to adjust the field-of-view and/or resolution to keep the size of the resulting ‘corrected’ diffusion data
manageable. To actually ‘see’ how the tool performed, you may want to compare this corrected result with
the ‘non-corrected’ data. You can do this, by checking one of the ‘rigid’ counterparts: e.g., ‘yes, to a single
data set (rigid)’ instead — then the output will just resample the data to the undistorted (T1) data space:

Uncorrected (rigid) for EPI distortions Corrected (non-rigid) for EPI distortions

By default, the non-linear deformations are allowed along any orientation. In practice, however, correction
will likely improve if the registration is constrained to model deformations only along the phase encoding
direction. To do this (assume: A-P orientation), change “Deformation axes” to [1 0 O].

elete Palette: Animations  Miscellanea Debug Desktop Window Help Plugins  Calculate DTI *.mat file

Tractography

HARDI
EN Glyphs
Image Map

Clustering

r v v v v ¥

Color map
Brain context
Analyze
Axis view
Width ROLrnarker
Probability atlas label
Robust estimaticn
DKI
Automated masking
Atlas based tractography
Use parallel computing ...
Define the Temp' folder
SM/EC/EPI correction

¥ Cleanup 'PIS'

Tensor estimation procedure

Masking stuff

Also register to other data?

Registration details for SM/EC correction

Set file name suffix

Export parameter file ...

Mo thanks (stay in native space)
yes, to a single data set (rigid) ...
yes, to associated data sets (rigid) ..

es, to do the EPI correction (non-rigid) ...

Define image type for registration
Registration details

Number of iterations ...
Mumber of samples ...
Mumber of histogram bins ...
MNumber of resolutions ...
Grid spacing ...

Deformation axes ...

And make sure you first use the plugin “Flip/permute dimensions in 3D/4D *.nii file(s)” to make your
nifti files (T1, T2, etc.) “ExploreDTI compatible”... this will avoid unexpected axis flips (& permutations) in
the resulting files.



12. Diffusion Kurtosis Imaging (DKI)
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To calculate the kurtosis parameters, just set ‘NaN’ as the b-value when converting your *.nii DWIs and *.txt

B-matrix to a *.mat file:

0 ExploreDTI's data converter to create DTI “.mat files

Format diffusion weighted data
Permute spatial dimensions
Flip spatial orientations
Perform visual data check
Diffusion tenser estimatien
Format diffusion information Text file (*.txt)

Background masking approach

Permute gradient components

Flip sign of gradient components
Data processing mode

b-value in units simm*2

Voxel size [AP RL IS] (in mm})
Number of non-DW images

Number of DW images

> [ ==
5 g o o
g 4 R
H] = r|| T
=3 - p—
(1] w w
4 4 4 4 4 4 4 4

Matrix size [AP RL IS] 128 128 60
Start converting to DTl ".mat file(s) ...

You can do everything (correction steps, DTI based tractography, etc.) as before. The most common kurtosis
metrics (MK, RK, AK, KA) can be exported from the ‘Export stuff to *.nii files’ tool in the menu item ‘Plugins’:

LS.
ADCs - reconstructed with DT model {"_ADCs_DT.nii’)

DWis - reconstructed with DT model [_DWIis_DT.nii")

DWI residuals from DT {"_res_DWI_DT.nii")

ADC residuals from DT {"_res ADC_DT.nii’)

Mask ("_mask.nii’)

Lattice Index ("_LLnii")

Mean of DWIs {_mean_DWIs.nii’)

Mean of Bls {_mean_B0s.nii")

HARDI (see settings) (_HARDI_Lmax_8 CSD_RF_NSim_0.8_8.nii")
Diffusion kurtosis tensor ii

Mode of anisotropy (_AM.nii’)

Diffusion tensor norm ("_DTN.nii’)
Skeletonized FA "_FA_Skeleton.nii’)

Axonal Water Fraction (from DKI) {"_AWF.nii’)

Select all

The REKINDLE (Robust Extraction of Kurtosis INDices with Linear Estimation) approach (default setting
while correcting for subject motion, eddy current induced distortions and/or EP| deformations) is preferred for
computing these kurtosis metrics (Tax C.M.W. et al, Magnetic Resonance in Medicine 73:794-808, 2015).
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13. Automated “atlas based” tractography

This tool is based on the work presented in Lebel et al. (http://www.ncbi.nlm.nih.gov/pubmed/18295509). In
summary, it works as follows. First, define a set of ROIs (AND/NOT gates) that would extract your tract of
interest (based on an atlas/template or on a representative single subject). Using this information (the
‘template’ and these regions-of-interest — ROIS), the tract of interest is automatically reconstructed for all
your data sets. Below, an example is given on how to do this for pathways of the right uncinate fasciculus (R-
UNC).

The input of this tool is a set of DTI *.mat files and their corresponding ‘whole-brain’ tract *.mat files. In this
example, the data sets were all in native space and the tracts were reconstructed with DTI. As you can see
below, there are just 3 subjects (FYI — the computation time is roughly 5 to 20 min per data set).

== - E]
Mame

Data_1.mat
Data_1_Tracts_DTLmat
Data_2.mat
Data_2 Tracts_DTLmat
Data_3.mat
Data_3_Tracts_DTLmat

m

I could use a nice FA template (there are many!), but in this example, | will create a ‘pseudo FA atlas
template’ myself from “Data_1”. So simply export the FA from ‘Data_1.mat’ via ‘Plugins’ - ‘Export stuff to
*.nii files’: select ‘Single data set’, then select the ‘FA’, and save it somewhere (e.g., in the same folder that
contains all the *.mat files):

Cemrrh Imnpt p |

v|¢?|

Mame

Data_l.mat
 Data_1l_FA.nii
%2 Data_1_Tracts DTLmat
Data_2.mat
Data 2 Tracts_ DTLmat
Data_3.mat
Data 3_Tracts_ DTLmat

&

i

&

m

i

Now, we are going to define the ROIs that will be used to reconstruct the pathways of the R-UNC. This is the
step that requires our ‘prior knowledge’ (aka ‘anatomical expertise’): “The uncinate fasciculus is a hook-
shaped bundle that links the forward portions of the temporal lobe with the inferior frontal gyrus and the lower
surfaces of the frontal lobe. It does this by arising lateral to the amygdala and hippocampus in the temporal
lobe curving in an upward pathway behind the external capsule inward of the insular cortex and continuing
up into the posterior part of the orbital gyrus.” — that is, according to the Wiki page! The idea now is to define
a configuration of AND/NOT ROIs that would select only these pathways and would leave out all other tract
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pathways of the brain. So let us create such ROIs for our ‘template’, i.e., ‘Data_1.mat’. First, load the DTI file:
‘Data_1.mat’ and then the tracts file: ‘Data_1_ Tracts DTIl.mat'. If you were to click ‘Draw tracts’, you would
see all of them (see below — but just do NOT do this — rendering will take forever!). | only do this to show the
location of the R-UNC pathways in the context of the rest of the brain. The R-UNC connects the temporal
(yellow) with the ‘inferior frontal’ (white) region.

Data_1_ Tracts_DTIl.mat

\

NI
Y
S

% ‘N \ \ \ : \\ “‘\ /’

N\

Y

So if | draw two AND ROls (as in the image above), the only tracts that would remain are these ‘fronto-
temporal’ connections. This is shown below (the yellow ROl above corresponds with the green ‘temporal’
AND ROI below on the left; the white ROI above corresponds with the green AND ROI below on the right):
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If you click ‘Analyse tracts’ (in the ‘Draw Tools’ palette) or in the menu item ‘Calculate’ > ‘Analyze tracts from
ROIs’, and then (after deleting the previous ‘whole-brain’ tracts display), click ‘Draw tracts’, you should see
the image below:

Ideally, only the tracts of interest (R-UNC) are left. In practice, however, there will probably be ‘spurious’ tract
pathways that are not part of the structure of interest, but still connect both ROIs (as is the case in this
example). These unwanted pathways can be removed by including NOT gates. Try to be as conservative as
possible to minimize excluding the ones that are ‘correct’. Below, two NOT ROIs are drawn: one covering the
entire mid-sagittal slice, and a second one on a coronal slice posterior (with some margin) to the temporal
ROI (after deleting the previous tract display, click ‘Analyse’ again and ‘Draw tracts’):

If you are happy with the end result, save each of the ROIs as a separate 3D *.nii mask (using ‘Data’ >
‘Save mask of ROIs’). In this example, | did not save each ROI yet, so | will save all the ROIs in one go with
‘Data’ - ‘Save multiple ROIs’. In doing so, | created a folder ‘ROIs_mat’ (below on the left):
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i Mame ’
= . Ml @
RQOIs_mat ;
% Data_l.mat Mame
# Data_1_FA.nii
%) Data_1_Tracts_DTLmat E ROLAMD_1.mat
£ Data 2.mat £ ROLAND_2.mat
Data_2_Tracts_DTLmat ¥ ROI NOT .mat
= ) Data_3.mat :
% Data_3 Tracts_DTLmat I ROLNOT_4.mat

In this folder (above right), there are now 4 ROIs. The following step consists of creating 3D *.nii files from
each of these ROIs. The resulting 3D *.nii masks have values ‘0’ representing the background and non-zero
values representing the actual ROI. First, delete all ROls in the current display, and load “ROl_AND_1.mat”
via ‘Data’ > ‘Load single ROI’ (below left) and then save it via ‘Data’ - ‘Save mask of ROI(s). A popup will
appear (below right). Here, you should choose ‘Nifti’ format.

r-o Saving mask of R... l — | |&

Which format for output?

Nifti (*.nii) Matlab (*.mat)

Then, another popup appears, asking you:

o Saving mask of ROIs L = i‘E—I

@ aND, HAOT, OR mask?

L AND (1)} |NDT(2}‘ ‘ OR (3} ‘

The choice here is not too important to be honest, as you just want to create a mask with ‘0’ values in the
background and non-zero values in the ROI. So just select ‘AND (1)’. The next step, however, which is giving
a name to this *.nii file, is crucial as it is the name itself (or at least part of it) that will reflect what type of ROI
mask it represents! So in this case, being an AND ROI, we name it: ‘ROI_AND_temporal.nii’ and put it in a
new folder that | created called ‘ROI_masks’ (see below).
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(e

Save in: I 1. ROI_masks j = I'j{ B2~

= Mame Date modified Type
Hecz"ﬁaces Mo items match your search.

-

Desktop

4 | m |

File name: IHOI_AN D _temporal nii j Save
Save as type: I {* i) LI

b
S|
Cancel |

/;' )

Again: there *should* be a part of the name that is called ‘ROI_AND’ — the rest (before or after ‘ROI_AND’)

can be anything (in this case ‘_temporal’). Now, you can do the same for the other ROIs. Analogously, for
the NOT ROls, there should be a part of the file name that is ‘ROI_NOT’ (see below).

der =~ 0 @ l

-

Mame

| |. ROLmasks
.. ROIs_mat
Data_l.mat .
? Dat _1 FA.nii ROI_AMD_frontal.nii
#] Uata_Ll_rA.nn

-]

ﬁ Data_1l_Tracts DTLmat I:I RGI—AN D‘_tEFI"I F"Dral'”ii
-]
-]

£ Data.2mat 3 ROLNOT_coronal.ni
H gﬁ“a'j'“”‘-““’”“ ROL NOT. imidsagittalni
ata_3.mat

ﬂ Data_3 Tracts DTLmat

Finally — now we can actually use the tool! So go to ‘Plugins’ > ‘Atlas based tractography segmentation’! If

you click it, there will be the request to select the ‘atlas template’. Here, you will select the FA map of our
‘representative’ subject, i.e., ‘Data_1_FA.nii’ (see below).



&) Select atlas template (3D *

Look in: I 0 Input

Marne
. ROL_masks
. ROIs_mat

| | Data_1_FA.nii

4| il

File name: IData_1_F.P«.nii

Files of type: | (i)

In the next step, select the folder of 3D *.nii masks:

Select the folder of 30 °...ROL_AND...", "...ROL_OR...",
andfor ... ROI_MNOT..." *ni file(s)

4 | B _Example_atlas_baszed_tractography =
4 | Input
| | ROLmasks
1. ROIs_mat (4
L Output i

Falder: ROI_masks

Make New Folder |

The next popup states:

[F&MD ROz exist, use zegment anly?

[ |
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Quick intermezzo! By ‘segment’, | refer to the piece that is between the two outer ROIs. As an example,
consider the two tract representations of (part of) the cingulum below. The right one is what | mean with
‘segment’ — so just a section, defined by the two ROIs.

Back to the R-UNC... So now, let us take the entire bundle of pathways (so click ‘No’ in the popup window).
Then, we need to select the folder that contains the DTI (and tract) *.mat files (see below).

Browse For Folder Iﬁ

Select the folder of OTI *.mat file(s)

4 1 8_Example_atlas_based_tractography =
4 | Input
; ROLmasks
|| , ROIs_mat
. Output i

Folder: Input

o) (o

——

After you select this folder, you get yet another popup asking you to fill in the suffix part of the tract *.mat file
and the suffix part for the name of the output tract *.mat name (see below — note: “it's case sensitive”).

r‘ Aflas based tractography analysis .. l = | =] Lﬁf

Extension name for whole brain tract * mat file (e.g.. *_tracts.mat')
_Tracts_DTl.mat

Extension name for the fiber bundle tract * mat file (e.g.:
' Left_Cingulum.mat"}

_R_UNC.mat

| Ok || Cancel |

_—




The final popup appears asking to select a folder to put the output files:

-

Browse For Folder

S

Select the folder to save the output *.mat tract file(s)

]

F

8_Example_atlas_based_tractography

Input
ROI_masks
ROIs_rmat

Cutput

rs

Folder:

Output

Make Mew Folder [ Ok

] | Cancel

And now ... have a cup of coffee (see below)!

-

0 Do not close waitbar: unexpected errors may occur!
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When this “wait bar” disappears, the analysis has finished and you should see output files like the ones

below:

.

MName

Data_L_R_UMC.mat
1 Data_1 R_UNC_T_template.nii
# Data_1_R_UMCT_ROLAND_L.nii
1| Data_1 R UNCT_ROL AND_2.nii
# Data_1_R_UMCT_ROILMNOT_1.nii
1| Data_1 R UNCT_ROL NOT_2.nii

Data_2_R_UMC.mat
1 Data_2_R_UNC_T_template.nii
# Data_2_R_UMCT_ROLAND_L.nii
s Data_2_R_UMCT_ROLAND_2.nii
1| Data_2 R_UNCT_ROL NOT _1.nii
# Data_2_R_UMCT_ROILMNOT_2.nii
%) Data 3 R_UNC.mat
¥ Data_3_R_UMC_T_template.nii
1| Data_3_R_UMNCT_ROL AND_1.nii
# Data_3_R_UMCT_ROLAND_2.nii
1| Data_3_R_UNCT_ROL NOT _1.nii
\# Data_3_R_UMCT_ROILMNOT_2.nii

L

I highlighted the tract *.mat files (above): these are the results! The other data sets are the warped templates

and ROlIs for each data set (just a post-hoc sanity check — or to see what went wrong if it did go wrong).
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So let’s just look at the R_UNC tract results for each data set below:

“Data_1 R_UNC.mat” (as expected — we used this one to define the R-UNC in the first place!)

‘Data_2 R_UNC.mat”

“Data_3_R_UNC.mat”

Not bad ;-)! Finally, to get the statistics of these tracts, use the tool ‘Plugins’ = 'Convert’ > ’ Info of tract
*.mat file(s) to *.txt". One more thing: with ‘Settings’ > ‘Atlas based tractography’ = ‘Tract length range’, you
can further constrain the output tracts to be within a specific length range (again — just an extra way of using
prior knowledge in the analysis).
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14. Network analysis tools...

If you think of the brain as a network of connections between brain regions, you may be interested in
investigating the properties of this network. With ExploreDTI, you can obtain the so-called “connectivity

matrices” (CMs), from which you can derive network properties, such as “efficiency”, “small-worldness”, etc.
In addition, with ExploreDTI you can create the typical network visualizations.

For more background information and example studies in which the network analysis tools of ExploreDTI
have been used, see the work of Reijmer YD et al (Neurology 2013, Diabetes 2013, Brain 2015) and
Caeyenberghs K et al (Brain Struct Funct 2014, Hum Brain Mapp 2014, Neuroimage Clin 2012, Front Hum
Neurosci 2013).

In the following, | will first explain how to compute the CMs. Note: there are two ways in ExploreDTI to obtain
these CMs: “From atlas template/labels” and “From predefined ROI labels” (see below). After that, | will show
you how to make network visualizations.

zlp | Plugins | Calculate DTI *.mat file

Correct for subject motion & EC/EPI distortions

‘Whole brain tractography

3D *.nii 2 3D *.nii

Export stuff to *.nii files

Flip left-right orientation of DTI *.mat file
Generate synthetic diffusion MRI data
Resample 30/4D *.nii file(s)

Flip/permute dimension(s) of 3D/4D *.nii file(s)
Shuffle/select 30 volume(s) in 40 *.nii file(s)
Get precisions (wild bootstrap) of DTI *.mat
Check motion/distortion correction

Check outlier profiles

Open 'MRIcreN' (€ Chris Rorden)

Crop size of *.nii file

Concatenate DTI *.mat files (to *.nii)
Concatenate tract *.mat files (to *.mat)
Generate diffusion gradient directions
Regularize D'WIs (4D *.nii)

Tract info from other modality

Closing the Venetian blinds

Perform uniform tract resampling
Surmnmary uniformly resampled tract *.mat files
Autormated FOV cropping of DTI *.mat files
Convert...

Get diffusion metrics from atlas labels
Gaussian smoothing (*.nii)

TV for Gibbs ringing in non-DWI's (4D *.nii)

Metwork analysis tools.., Get ‘connectivity' matrices... From atlas template/labels

Atlas based tractography segmentation Get Label coordinates... From predefined ROI labels

Mask 3D *.nii file... Get Label volumes & surface areas...

Create template labels from MNI coordinates...

Calculate connectivity SMR...

The difference, in a nutshell, is that with the “From atlas template/labels” tool, you will need an atlas template
with associated labels (ROIs), which will be registered to each subject’s data set. With the other tool (“From
predefined ROI labels”), the ROIls are already derived with another approach (for instance, a T1-based
cortical segmentation) and located in the same image space as the diffusion data (see example p. 44).
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Let's have a look at the “From atlas template/labels” tool. For each subject, you will need the following data
sets: a DTI *.mat file and its associated whole-brain tracts data set (see example below for 2 subjects):

Burn

s

Mew folder

Marme

DTI_data_Subj_01.rnat
DTI_data_Subj_01_Tracts.mat
DTI_data_Subj_02.mat
DTI_data_Subj_02_Tracts.mat

The other files that you will need to run this tool are related to the atlas that you want to use. As an example,
let's consider the AAL atlas (see: Tzourio-Mazoyer N et al, Neurolmage 2002). Converted for ExploreDTI
purposes, the relevant AAL atlas information is how represented in three files:

Mame

- —]|

AAL Label_Mames.bd

|® AAL |abels.nii
|# AAL Template.nii

You can download these files from: http://www.exploredti.com/templates/AAL Template.zip. This one and

other examples of such atlas template/label files are provided in the folder “~/Source/Templates”.

The *.txt file consists of two columns: the first column contains “0” or “1” values (meaning “0”: do not use this
ROI in the analysis; “1”: do use it for analysis) and in the second column, the label name of the ROI is given.

Each ROl is given on a separate row:

#

mj Adl Label_Mames.txt - Notepad

File Edit

Format Wiew Help

Frontal
Frontal
Frontal
Frontal
Frontal
Frontal
Frontal
Frontal
Frontal
Frontal
Frontal
Frontal
Frontal
Frontal

L PRERERERRERRRRRERRRE R

Precentral L
Precentral R

Sup
sSup
Sup
sup
Mid
Mid
Mid
Mid
nf
nf
nf
nf
inf
nf

L

=3

orb L

orb r

L

=1

orb L

orb r

Oper L
Oper R
Tri L

Tri R

orb L

orb r

Rolandic oper L

The actual row number *is* important as it represents the intensity value in the associated “Labels” file. So in
this case, the 3D nifti file “AAL_Labels.nii” contains the ROIls described in the *.txt file above. More
specifically, the region with “0” values is background, the region with intensity values of “1” represents
“Precentral L”, the region with intensity values of “2” represents “Precentral R”, etc. The corresponding AAL
atlas template (here, “AAL_Template.nii”) is needed to perform the registration. Both files are shown below

with MRIcron:


http://www.exploredti.com/templates/AAL_Template.zip
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-
Z# mricron.exe - C\ExploreDTDAAL_Labels.nii | =[5 i:h]

File Edit Owerlay DOraw | View | Window Help

Backgound = |.9| 1.0000 = 920000 = Grapscale -|g,:g”.:)‘

“E 2lv10s 2z 90 2 toft -

Tx-1%-1= 0.00000

.
<@ mricron.exe - C:\ExploreDTINAAL Template.nii I =aEen X
File Edit Overlay Draw View Window Help
Bl 2v108 2z90 2 toft &‘.

Backgound v ()| 00078 (2] 0853 & Giayscdle v

0l

il

1x-1x-1= 0.25564

Let’s actually run this tool now... Go to “Plugins” and then (see below) “From atlas template/labels” (btw, to
speed up things, you may want to use the “Use parallel computing...” option in “Settings” — make sure you
have enough memory... memory usage will be proportional with the number of cores that you define and can
be roughly in the order of 2 GB per core).

Gaussian smoothing (*.nii) 4
TV for Gibbs ringing in non-DWT's (4D *.nii)

Netwaork analysis tools... [ Get ‘connectivity' matrices... From atlas template/labels
Atlas based tractography segmentation Get Label coordinates... From predefined ROI labels
Mask 30 *.nii file... Get Label velumes & surface areas...

Create template labels from MNI coordinates...

Calculate connectivity SMR...




The steps to follow are first:

Then:

Then:

Then:
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’
' Select atlas labels (30 *.nii)

——,
@U'| ) <« Local Disk (C:) » ExploreDTI

Organize = Mew folder

Mame

| AAL_Labels.nii
|®| AAL Ternplate.nii

r
) Select atlas template (3D *.nii)

QO-

Organize - Mew folder

1. ¢ Local Disk (C:) » ExploreDTI »

Mame

Ji Data
|® AAL_Labels.nii
|| AAL_Template.nii

~
‘ Select label names (two column * )

—r,
OU [0« Local Disk (C) » ExploreDTI »

Organize * Mew folder

Mame

. Data
| AAL Label_Mames.bd

-
‘ Select the folder of DTI *.mat file(s)

e
@U'| ) « Local Disk (C:) » ExploreDTl » Data

Organize = MNew folder

Marne . Date modifu
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Recall... this is the folder that also contains the *.mat tract files (see below - this is important for the next

step).

uter

» Local Disk (C:) » ExploreDTI » Data

s Help

gin library - Share with - Burn M

-~

Mame

i

A

A

4+

DTI_data_Subj_01.mat
DTI data_Subj_01_Tracts.mat
DTI_data_Subj_02.mat
DTI_data_Subj_02_Tracts.rmat

Then you need to enter the end-part of the tract file name — simply to find the corresponding files (note: this

is case-sensitive!):

-
0 Metwork analysis .. E@g

Extension name for tract *.mat file (e.g.. *_tracts.mat’)

Extension name for 30v4D0 * nii volume file (e.g.. " _MTR.nif"}

[ox_] [cancel]

Keep the second line empty (unless you have a *.nii file that is registered to the diffusion data that you want

to integrate in this pipeline... anyway, I'll explain this particular feature on another occasion).

The next step is then to select the folder to save all the output (here, | made a folder called “Output” — just

because | can):

-

Then the next pop-up appears:

Select the folder to save the output *.mat networ

@Qv| , ¢ ExploreDTI » Data »

Organize MNew folder

-
Mame

. Output

-
) Exporting fiber bundles... E‘;Iﬂ

Alzo export inter-label tract bundles to tract * mat files?

] e
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Well — as it says, you can choose to save tracts (if there are any) between the different combinations of the
ROIs defined in the template. Let us proceed with yes, then the following pop-up shows all these potential
ROI combinations (as an example, I'll choose the tracts that connect the left anterior and posterior cingulate
cortices):

il N
6 Select inter-label tract bundles | =] o S

Cingulum Ant L_conn_Calcarine L
Cingulum Ant L_conn_Calcarine R
Cingulum Ant L_conn_Caudate L
Cingulum Ant L_conn_Caudate R
Cingulum Ant L

Cingulum Ant L_conn_Cingulum Ant R
Cingulum Ant L_conn_Cingulum Mid L
Cingulum Ant L_conn_Cingulum Mid R

Cingulum Ant L_conn_Cingulum Post R
Cingulum Ant L_conn_Cuneus L
Cingulum Ant L_conn_Cuneus R
Cingulum Ant L_conn_Frontal Inf Oper L
Cingulum Ant L_conn_Frontal Inf Oper R
Cingulum Ant L_conn_Frontal Inf Orb L
Cingulum Ant L_conn_Frontal Inf Orb R
Cingulum Ant L_conn_Frontal Inf Tri L
Cingulum Ant L_conn_Frental Inf Tri R
Cingulum Ant L_conn_Frontal Med Orb L
Cingulum Ant L_conn_Frontal Med Orb R
Cingulum Ant L_conn_Frontal Mid L
Cingulum Ant L_conn_Frontal Mid Orb L
Cingulum Ant L_conn_Frontal Mid Orb R
Cingulum Ant L_conn_Frontal Mid R
Cingulum Ant L_conn_Frontal Sup L
Cingulum Ant L_conn_Frontal Sup Medial L
Cingulum Ant L_conn_Frontal Sup Medial R
Cingulum Ant L_conn_Frontal Sup Orb L
Cingulum Ant L_conn_Frontal Sup Orb R
Cingulum Ant L_conn_Frontal Sup R
Cingulum Ant L_conn_Fusiform L
Cingulum Ant L_conn_Fusiform R
Cingulum Ant L_conn_Heschl L
Cingulum Ant L_conn_Heschl R
Cingulum Ant L_conn_Hippocampus L
Cingulum Ant L_conn_Hippocampus R
Cingulum AntL_conn_Insula L

Cingulum AntL_conn_Insula R
Cingulum Ant L_conn_Lingual L
Cingulum Ant L_conn_Lingual R
Cingulum Ant L_conn_Occipital Inf L
Cingulum Ant L_conn_Occipital Inf R
Cingulum Ant L_conn_Occipital Mid L

™ inn . fn o ) inital Mid B

Select all

These files can be loaded into ExploreDTI afterwards (sanity checks!) or used for other analysis purposes...
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The final pop-up before the processing actually starts is:

o Type of connection between label ROLs... | = _S;h]
@ Chooze 'PASS', 'EMD', or bath 'PASS" and ‘END'
[ eass | END | | passanaeno

In short, with ExploreDTI you can differentiate between tract pathways “passing through” two ROIs and those
that actually “end” in these ROIs (see sketch below). In current literature, this differentiation is generally not
made — the “pass” definition is implicitly taken then. FYI — there is hardly any extra computational cost if you

compute both (“pass” and “end”), hence the third option.

“PASS” definition: A is connected to B, Bis connected to C, A is connected to C
“END” definition: A is connected to C (the pathway terminates in regions A and C, but not in B)

Processing time per data set is approximately 10 min to 2 h depending on your hardware specs, data size,
etc. The output files are (FYI, | chose the “PASS and END” option):

(1) “Temp_atlas_labels.nii”: this is simply the “template labels” file of the atlas, but then only with the
ROlIs that you have selected for analysis (recall: the first column in the text file being “0” or “1”). In
this example, notice that the cerebellar ROIs are not included. This data set will be useful for

visualization purposes (see later).

<8 mricron.exe - C\ExploreDTI\Data\Output\Temp_atlas_Labels.nii |£|Eléj

File Edit Overlay Draw View Window Help

KE Ay 2z e 2 wofit - &
Background - .ja 10000 [ BA00O0 2 Gragpsesle v (€)@

-31%1= 0.00000




p. 43

(2) For each subject, there will be a “Template_X.nii” and a “Labels_X.nii” file with the “X” representing
the tract file name (so in this example, the “X” is “DTI_data_Subj_01_Tracts” for subject 1 and
“ DTl _data_Subj 02 Tracts” for subject 2):

|¥| Labels_DTI_data_Subj_01_Tracts.nii
|#| Template_DTI data_5Subj 01_Tracts.nii
|%| Labels_DTI_data_Subj_02_Tracts.nii
|#| Template_DTI_data_Subj_02_Tracts.nii

The “Template_X.nii” and “Labels_X.nii” files are just the transformed “template” versions for each
subject (this output serves for quality control).

(3) If you chose to export “inter-label” tract bundles, these will be located in “temp_X” folders with the X
reflecting the subject tract file names (with “END” / “PASS” specification). In this example:

Mame

, temp_PASS_DTI data_Subj_02_Tracts
J temp_EMD_DTI data_Subj_02_Tracts
, termp_PASS_DTI data_Subj_01_Tracts
J temp_EMD_DTI data_Subj_01_Tracts

(4) The actual “connectivity matrices” (CMs)! For each subject, the following *.mat files are generated (|
highlighted the files for subject 1):

v » Local Disk (C:) » ExploreDTI » Data » OQutput » v|4-f|| Search Qutput jel
Help
Burn Mew folder 55~ 0 @
i , temp_END_DTI data_Subj 01 Tracts # DTI data_Subj_01_Tracts_FA_PASS.mat
. temp_EMD_DTI_data_Subj_02_Tracts £ DTI_data_Subj_01_Tracts_FOD_END.mat
. temp_PASS_DTI data_Subj 01_Tracts T DTI data_Subj 01_Tracts FOD_PASS.mat
3 . temp_PASS_DTI _data_Subj_02_Tracts %] DTI_data_Subj_01_Tracts_inter_label_distances.mat
£ DTI_data_Subj_01_Tracts_AD_END.mat % DTI_data_Subj_01_Tracts_L2_END.mat
T DTI data_Subj 01_Tracts AD _PASS.mat T DTI data_Subj 01 _Tracts L2 PASS.mat

%] DTI_data_Subj_01_Tracts_average_tract_length_EMD.mat %7 DTI_data_Subj_01_Tracts_L3_END.mat
%] DTL_data_Subj_01_Tracts_average_tract_length_PASS.mat | | DTL data_Subj_01_Tracts_L3_PASS.mat

) DTI_data_Su bj_01_Tracts_binary EMD.mat ) DTI_data_Su bj_01_Tracts_MD_EMND.mat
%] DTI_data_Subj_01_Tracts_binary_PASS.mat %7 DTI_data_Subj_01_Tracts_MD_PASS.mat
) DTI_data_Su bj_01_Tracts_CL_EMD.mat ) DTI_data_Su bj_01_Tracts_number_of_tracts END.mat
1 DTI data_Su bj_01_Tracts CL_PASS.mat 1 DTI data_Su bj_01_Tracts_nurmber_of tracts PASS.mat
£ DTI_data_Subj_01_Tracts_CP_EMD.mat %] DTI_data_Subj_01_Tracts_percentage_of tracts_END.mat
) DTI_data_Su bj_01_Tracts CP_PAS5.mat ) DTI_data_Su bj_01_Tracts_percentage_of tracts PASS.mat
£ DTI_data_Subj_01_Tracts_C5_EMD.mat £ DTI_data_Subj_01_Tracts_RD_END.mat
£ DTI_data_Subj_01_Tracts_C5_PASS.mat %7 DTI_data_Subj_01_Tracts_RD_PASS.mat
) DTI_data_Su bj_01_Tracts_density_weight_EMD.mat ) DTI_data_Su bj_01_Tracts_tract_volume_EMD.mat
£ DTI_data_Subj_01_Tracts_density_weight_PASS.mat % DTI_data_Subj_01_Tracts_tract_velume_PASS.mat
%] DTL_data_Subj_01_Tracts_FA_END.mat %] DTL_data_Subj_02_Tracts_AD_END.mat
- 4 T 3

ted

tils...

As you can see, there are CMs for “PASS” and “END” definitions. Each *.mat file contains one
variable, called “CM” and is simply an N x N matrix with N the number of ROIs in the analysis.
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There are many ways to construct a CM. The value at position (i,j) of CM either represents the “number of
tracts” (*_number_of tracts_*), fractional anisotropy (*_FA_*), mean/axial/radial diffusivity (*_ MD/AD/RD_*),
second/third eigenvalue (*_L2/L3_*), the linear/planar/spherical (“Westin”) anisotropy measures
(*_CL/ICP/CS_*), the average tract length (*_average_tract length_*), the binary value: connection or not
(*_binary_%*), the density weight (see definition in P. Hagmann et al PLoS Biol 2008, * density weight_*),
percentage of tracts (*_percentage_of tracts_*), tract volume (*_tract_volume_*), the distance between the
ROI centers of gravity (*_inter_label_distances_*), and in case of CSD: the amplitude of the fiber orientation
distribution (*_FOD_*) of the fiber bundle connecting ROI “i” with ROI “j”.

For the other option, “From predefined ROI labels” (see below), the only difference is that for each subject,
you’ll need a separate 3D *.nii file (same name, but with suffix added, such as “_labels.nii’) with ROIs in a
similar format to the “atlas labels” *.nii file from above. Note that these “label” files must be in the same space
of the diffusion data (computation times are in the order of a few minutes to a few hours per data set,
depending on size).

Gaussian smoothing (*.nii) 4
TV for Gibbs ringing in non-DWI's (4D *.nii)

Netwaork analysis tools... ) Get 'connectivity' matrices... ' From gtlas template/labels
From predefined ROI labels

Atlas based tractography segmentation Get Label coordinates... [
Mask 30 *.nii file...

Get Label volumes & surface areas...

Create template labels from MNI coordinates...

Calculate connectivity SMR...

I will explain the “From predefined ROI labels” plugin with an example. Assume you want to compute the
ROIs with FreeSurfer.

After using FreeSurfer (“recon -all”), the result should be something like the folder structure shown on the left
below:

Mame

orig
transforms
| xdebug_mris_calc
|| aparc.a2009s+aseg.mgz
|| aparc+aseg.mgz
|| aseg.auto.mgz
| aseg.aute_noCCseg.label_intensities. bt

| aseg.aute_noCCseg.mgz

i Marne L_| aseg.mgz
__| brainfinalsurfs.mgz
bem || brain.mgz
label || brainmask.auto.mgz
i __| brainmask.mgz
scripts || ctrl_pts.mgz
cre || filled.mgz
1 stats _| Ih.ribbon.mgz
r T 2] mri_nu_correct.mnilog
rri_nu_correct.mnilog.bak
tmp j—
| nerm.umgz
touch
|| numgz
trash
| nu_ncneck.mgz
|| orig.mgz
2| orig_nu.log

The important folder for now is “mri” and looks something like the right above.


http://surfer.nmr.mgh.harvard.edu/

First, convert the FreeSurfer stuff to “ExploreDTI compatible *.nii files”:

Help | Plugins | Calculate DTI *.mat file

Correct for subject motion 8 EC/EPI distortions

Whele brain tractography

3D *.nii 23D *.nii
Export stuff to *.nii files
Flip left-right erientation of DTI *.mat file
Generate synthetic diffusiocn MRI data
Resample 3D/4D *.nii file(s)
Flip/permute dimension(s) of 30/4D *.nii file(s)
Shuffle/zelect 30 volume(s) in 4D *.nii file(s)
Sort W *.nii file(s) wrt b-values
Get precisions (wild bootstrap) of DTI *.mat
Check motion/distortion correction
Check outlier profiles
COpen 'MRIcreMN' (€ Chris Rorden)
Crop size of *.nii file
Concatenate DTI *.mat files (to *.nii)
Concatenate tract *.mat files (to *.mat)
Generate diffusion gradient directions
Regularize DWIs (4D *.nii)
Tract info from other modality
Closing the Venetian blinds
Perform uniform tract resampling
Surmmary uniformly resampled tract *.mat files
Autornated FOV cropping of DTI *.mat files
Convert... Info of tract *.mat file(s) to *.tt
Get diffusion metrics from... * bval/*.bvec to B-matrix *.tet file(s)
Gaussian smoothing (*.nii) B-matrix in DTI *.mat file(s) to *.bval/*.bvec file(s)
TV for Gibbs ringing in non-DWI's (4D *.nii) 3D *.nii 'stack’ to 4D *.nii
MNetwork analysis tools... Dicom folder(s) to *.nii files
Atlas based tractography segmentation Diffusion *.par/*.rec to *.nii/* .t (version 1}
Mask 30 *.nii file... Diffusion *.par/™.rec to *.nii/* .t (version 2}
‘Zdseq’ to *.nii
‘methed’ to B-matrix *.bd
img/*.hdr' to *.nii
Tract *.mat file(s) to *wtk
Folder of images to movie (uncompressed *.avi)
*.nii to *.nii.gz (compress)
*.nii.gz to *.nii (decompress)
Freesurfer files to *.nii

Freesurfer parcellations (*.nii) to E_DTI format

Select multiple:

0 oo

Single or multiple data zets?

| Kuttiple |

Then select that “mri” folder:



Mame

orig

transforms

Just make a new folder “nii” and select it as the output folder

Mew folder
Mame

nii

arig

transforms

Then wait a bit:

° Do not close waitbar: unexpected errors may occur! |£|_Iéj

Waithar

The result looks something like:

Mame

|¥| aparc.a2009s+aseq.nii
aparc+aseg.nii
aseq.auto.nii
aseg.auto_noCCseg.nii
aseq.hii
brain.finalsurfs.nii
brain.nii
brainmask.auto.nii
brainmask.nii
filled.nii

Ih.ribbon.nii

norm.mii

nu.nii

nu_noneck.nii

orig.nii

orig_nu.nii

rawavi.nii
rh.ribbon.nii
ribbon.nii

T1.nii

8| wrn.asegedit.nii

[ [&)[o) [&)[& [& [& [& [& (& [6 [& (&) [ [& e (& & [

|8 wrm.nii
|#| wrmn.seg.nii

|| wmparc.nii

p. 46
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The “brain.nii” file is now actually useful! If your DTl *.mat file (the “uncorrected data™) is called:
“Sub_01.mat”’, then rename this “brain.nii” file to “Sub_01_T1 brain.nii’. Now you can use
“Sub_01_T1_brain.nii” for doing the SM/EC/EPI distortion correction step (see p. 24/25). Make sure you
change the deformation axes settings to [1 0 0] (assuming you have the PE along the AP axis). The result
after applying the “Correct for subject...” plugin should be something like:

Name

Sub_01.mat
Sub_01_MD_C_native.mat
Sub_01_MD_C_trafo.mat
¥ Sub_01_T1_brain.nii

Quick intermezzo: You can check the result by overlaying the color-coded FA with the T1.:

o Figures - ExploreDTI v4.84 - © Alexander Leemans

Image map  Axis Draw Calculate Color

Load DTI (*.mat) Ctrl+L

Load volume (*.mat,*.nii)

Load fiber tracts (*.mat) :
Load single ROI (*.mat)

Load multiple ROIs (*.mat) -

Load CSD FOD (*.mat.".niil L]

Mew folder

Name

Sub_01.mat
% Sub_01_MD_C_native.mat
% Sub_01_MD_C_trafo.mat

0 Figures - ExploreDTI v4.8.4 - © Alexander Leemans F'

Data | Imagemap Axis Draw Calculate Color

Load DTI (*.mat) Ctrl+
Load volume (*.mat,*.nii) /
Load fiber tracts (*.mat)

Load single ROI (*.mat)

Load multiple ROIs (*.mat)
Load C5D FOD (*.mat,*.nii)

Cave filher tracte ™ rat * nil ® Bl
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New folder

o MName

% sub_01.mat

%] Sub_01_MD_C_native.mat

% sub_01_MD_C_trafo.mat
E % Sub_01_T1_brain.nii

0 Figures - ExploreDTIv4.84 - © .

Data | Imagemap | Axis Draw
il = )
v

Yolume

ngs | Palettes | Animations Miscellanea

Axis

Draw
PASTA
QA DWIs
QA Volume

Multi-fiber visualization

Minval [ 1]

Volume QA tools

XPlane
© Orthographic @ Perspective
® Zoom ® Move HV ® Move FiB

© Orbit @ Orbit Light

New Center Reset Toggle Light




Osts imogemsp Aus Orsw Colculste Color Show Mide Delete Settings Polettes Animations | M

Hide W Reverse view M Cross hairs

Debug Desktop Window Help Plugins  Calculate DT " mat fle

© Orthographic @ Perspoctive

® Zoom ® Move HV ® Move FiB

© Orbit ® Orbit Light

New Center Reset Toggle Light

“Miscellanea - Fuse CV with FEFA”... Looks good!

Now do some fiber tractography: DTI or CSD based — whatever you like ;-)! FYI, | named the resulting tract
file: “Sub_01_MD_C _trafo_Tracts.mat”.

Mame

%] Sub_01.mat

%] Sub 01_MD_C_native.mat

%] Sub 01_MD _C_trafo.mat

%] Sub 01_MD _C_trafo_Tracts.mat
| Sub_01_T1_brain.nii

Now, we’re going to convert the freesurfer *.nii parcellations to ExploreDTI compatible *.nii parcellations (this
produces the label *.txt files as well):

Make a new folder “E_DT]I” in the “nii” folder:

MName

E_DTI
|| aparc.a2009s+aseg.nii
|| aparc+aseg.nii
|| aseg.auto.nii
|*| aseg.auto_noCCseg.nii
|| aseg.nii
\#| brain.finalsurfs.nii
brain.nii
brainmask.aute.nii
brainmask.nii
filled.nii
Ih.ribbon.nii
nerm.nii
nu.nii
nu_naoneck.nii
orig.nii
orig_nu.nii
rawavg.nii
rh.ribbon.nii
ribbon.nii
T1.nii
wmn.asegedit.nii
WL

Wim.seg.nii

[ [&) [&) (&) [& [& (& [& & (& [@) (& (e [& [& & [e &

wmparc.nii



In Plugins, go to:

SURTIITIATY UNIOTITY [ESaMIpIed Uil IrdL s
Automated FOV cropping of DTI *.mat files -_
Convert... Info of tract *.mat file(s) to *.bd

Get diffusion metrics from... * bval/*.bvec to B-matrix * .t file(s)

Gaussian smoothing (*.nii) B-matrix in DT *.mat file(s) to *.bval/* bvec file(s)
TV for Gibbs ringing in non-DWI's (4D *.nii) 3D *.nii 'stack’ to 4D *.nii

Metwork analysis tools.., Dicom folder(s) to *.nii files

Atlas based tractography segmentation Diffusion *.par/*.rec to *.nii/*tet (version 1)

Mask 3D *.nii file... Diffusion *.par/*.rec to *.nii/* .t (version 2)
‘2dseq’ to *.nii
‘method’ to B-matrix *.bd
*img/*.hdr' to *.nii
Tract *.mat file(s) to *wik
Folder of images to movie (uncompressed *.avi)
*.nii to *.nii.gz (compress)
*.nii.gz to *.nii (decompress)
Freesurfer files to *.nii

Freesurfer parcellations (*.nii] fo E_DTI format

. L L e Sy -\.-——- — | —

Single or muktiple data sets?

| Singe | | Multiple ‘

And select the “nii” folder as input and the “E_DTI” folder as output. Then wait a few seconds...
The output is now something like:

|*| aparc.a2009s+aseg_E_DTLnii
aparc.a2ll9s+aseg_E DTI colortd
aparc.a2l09s+aseg_E DTI labels.txt

[&) |

aparc+aseg_E_DTLnii
|| aparc+aseg_E_DTI colortxdt
|| aparc+aseg_E_DTI labels.td
|| aseg.auto_E_DTLnii |#| Ih.ribbon_E_DTLnii
__| aseg.auto_E_DTI color.txt __| Ih.ribbon_E_DTI_color.tdt
L aseg.auto_E_DTI labels.tbt __| Ihribbon_E_DTI labels.tet
|#| aseg.autc_noCCseg_E_DTLnii & rhoribbon E DTLnii
|| aseg.auto_noCCseg_E_DTI colortd [y rh.rihbDH_E_DTI colorixd
|| aseg.auto_noCCseg_E_DTI labels. b [y rh.ril::ll::ll:lr‘l_E_D'I'I_Ial:lels.trI:
(2] aseg E_DTLnii | ribbon_E_DTLnii

aseg_E_DTI colortbd
|| aseg_E_DTI labels.te
|| filled_E_DTLnii

|| filled_E_DTI_color.tdt
| filled_E_DTI labels.txt
#| [h.rihhon F DTLAi

|| ribben_E_DTI_colort:d
|| ribben_E_DTI labels.txt
|*| wmparc_E_DTLnii

|| wmparc_E_DTI_color.txt
|| wrnparc_E_DTI_labels.tet
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Use for instance the “Desikan-Killiany” atlas (“aparctaseg_E_DTI") and only the relevant labels (change “1”
values to “0” if you do not want to use them):

Mj aparc+aseg_E_DTI_labels.txt - Notepad

File Edit Format View Help

Left-Cerebral-white-matter
Left-Lateral-ventricle
Left-Inf-Lat-vent
Left-Cerebel Tum-white-Matter
Left-Cerebellum-Cortex
Left-Thalamus-Proper
Left-Caudate

Left-Putamen
Left-Pallidum
3rd-ventricle
4th-ventricle

Brain-stem
Left-Hippocampus
Left-amygdala

C5F

Left-Accumbens-area
Left-ventralDc

Left-vessel
Left-choroid-plexus
right-Cerebral-white-matter
Right-Lateral-ventricle
Right-Inf-Lat-vent
Right-Cerebel lum-white-matter
rRight-CerebelTum-Cortex
right-Thalamus-Proper
rRight-caudate
Right-Putamen
rRight-rPalTlidum
Right-Hippocampus
rRight-amygdala
rRight-accumbens-area
Right-ventralbC
Right-vessel
rRight-choroid-plexus
wWM-hypointensities
non-wM-hypointensities
optic-chiasm

CC_Posterior
CC_Mid_Posterior
CC_cCentral

cCc_Mid_Anterior
cc_anterior

ctx-1h-unknown
ctx-lh-bankssts
ctx-lh-caudalanteriorcingulate
ctx-lh-caudalmiddlefrontal
ctx-Th-cuneus
ctx-Th-entorhinal
ctx-1h-fusiform
ctx-lh-inferjorparietal
ctx-lh-inferiortemporal
ctx-lh-isthmuscingulate
ctx-1h-lateraloccipital
ctx-lh-Tateralorbitofrontal
ctx-1h-Tingual
ctx-Th-medialorbitofrontal
ctx-Th-middletemporal

RFRRRRRRRRRRRRRFOC0000 00000 0ORRRERERFFOOD0D000ORHRORFROODRRRRODOD OO

-~

Nj aparc+aseg_E_DTI |abels.txt - Notepad

File Edit Format View Help

PRERRPRERRERRERPRRRERPRERRERRERRRRERRRRRRERRRROR R R R R R R R R R R R

ctx-1h-middTetemporal
ctx-1h-parahippocampal
ctx-Th-paracentral
ctx-1h-parsopercularis
ctx-lh-parsorbitalis
ctx-1h-parstriangularis
ctx-Th-pericalcarine
ctx-1h-postcentral
ctx-lh-posteriorcingulate
ctx-Th-precentral
ctx-1h-precuneus
ctx-lh-rostralanteriorcingulate
ctx-Th-rostralmiddiefrontal
ctx-Th-superiorfrontal
ctx-1h-superiorparietal
ctx-1h-superiortemporal
ctx-Th-supramarginal
ctx-1h-frontalpole
ctx-lh-temporalpole
ctx-1h-transversetemporal
ctx-1h-insula
ctx-rh-unknown
ctx-rh-bankssts
ctx-rh-caudalanteriorcingulate
ctx-rh-caudalmiddlefrontal
ctx-rh-cuneus
ctx-rh-entorhinal
ctx-rh-fusiform
ctx-rh-inferiorparietal
ctx-rh-inferiortemporal
ctx-rh-isthmuscingulate
ctx-rh-lateraloccipital
ctx-rh-lateralorbitofrontal
ctx-rh-1ingual
ctx-rh-medialorbitofrontal
ctx-rh-middletemporal
ctx-rh-parahippocampal
ctx-rh-paracentral
ctx-rh-parsopercularis
ctx-rh-parsorbitalis
ctx-rh-parstriangularis
ctx-rh-pericalcarine
ctx-rh-postcentral
ctx-rh-posteriorcingulate
ctx-rh-precentral
ctx-rh-precuneus
ctx-rh-rostralanteriorcingulate
ctx-rh-rostralmiddlefrontal
ctx-rh-superiorfrontal
ctx-rh-superiorparietal
ctx-rh-superiortemporal
ctx-rh-supramarginal
ctx-rh-frontalpole
ctx-rh-temporalpole
ctx-rh-transversetemporal
ctx-rh-insula

So, here, a total of 84 nodes... Just as an example.
But feel free to use another parcellation scheme!

Now rename the label file “aparc+aseg_E_DTI.nii” to “Sub_01_MD_C_trafo_labels.nii” and put it in the folder
with the *.mat DTI file (move non-relevant files to another folder and make a folder “output”):

Mame

| output
|| Label_names.txt
% Sub_01_MD_C_trafo.mat
|*| Sub_01_MD_C_trafo_labels.nii
% Sub_01_MD _C _trafo_Tracts.mat

BTW — | just renamed “aparctaseg_E_DTI_labels.ixt” to “Label_names.txt”, but not really necessary (and
only one such *.txt file is needed for all subjects when using the network tool below).



Now — finally ready to use the network tool (make sure you have enough RAM on your PC!):

Gaussian smoothing (*.nii) 4
TV for Gibbs ringing in non-DWI's (4D *.nii)

MNetwork analysis tools... ) Get 'connectivity' matrices...
Atlas based tractography segmentation Get Label coordinates... '

Mask 30 *.nii file...

Get Label volumes & surface areas...
Create template labels from MMI coordinates...

Calculate connectivity SNR...

From atlas template/labels
From predefined ROI labels

p. 52

Select the folder with the DTI *.mat files (in this example only 1 subject is in it, but it works for multiple

subjects too):

Mew folder
Name
output
Given this below:
Name .
output

__ Label_names.td
%] Sub_01_MD_C_trafgma
%] Sub_01_MD_C_tra

£ Sub_Ol_MD_C_tra

It should be clear that (set the “volume *.nii file extension” to “empty”):

game for tract * mat file

==

Extenzion name for 30v4D * nii volume file (22t empty if not relevant)

e for 30 *.nii ROI labels file

| Cancel |

Then, select the text file:

Mame

output

. Label_names.tdt

Then... similar as before... | say “No” here for sake of simplicity (see below):

\# Exporting fiber bundles.

Alzo export inter-label tract bundles ta tract *mat files?




p. 53

Then, choose the “type of connection” (END/PASS) — see above for explanation... Just select both for now
(not too much additional computational cost anyway):

o Type of connection between label ROLs... | = &J
@ Chooge 'PASS'. 'END', or both 'PASS" and 'END' /
: f =
i pass | END | | Passandenn |
h .

And finally, select the output folder:

- Mame
output
And then wait...
° Do not close waitbar: unexpected errors may occur! |£|_|éj

Could be a few hours per subject... depending on PC specs! But it can be parallelized with the setting
(again: check RAM!!I):

Delete | Settings | Palettes  Animations  Miscell

Tractography 4
HARDI
Glyphs
Image Map

Clustering

Color map

Brain context

Analyze

Asxis view

Width ROL/marker

Probability atlas label

Robust estimation

DKI

Automated masking

Atlas based tractography
v Use parallel computing ...

Define the Temp' folder

The output is as before (see p. 42-44):
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Mame

%] Sub_01_MD_C_trafo_Tracts_AD_EMD.mat

%] Sub_01_MD_C_trafo_Tracts AD_PASS.mat
Sub_01_MD_C_trafo_Tracts_average_tract_length_EMD.mat
Sub_01_MD_C_trafo_Tracts_average_tract_length_PASS.mat
% Sub_01_MD_C_trafo_Tracts_binary_END.mat

% Sub_01_MD_C_trafo_Tracts_binary_PASS.mat
Sub_01_MD_C_trafo_Tracts_CL_EMD.mat

%] Sub_01_MD_C_trafo_Tracts_CL_PASS.mat

%] Sub_01_MD_C_trafo_Tracts CP_END.mat

%] Sub_01_MD_C_trafo_Tracts CP_PASS.mat
Sub_01_MD_C_trafo_Tracts_C5_EMD.mat

%] Sub_01_MD_C_trafo_Tracts_C5_PASS.mat
Sub_01_MD_C_trafo_Tracts_density_weight_END.mat
Sub_01_MD_C_trafo_Tracts_density_weight_PASS.mat
Sub_01_MD_C_trafo_Tracts_FA_END.mat

%] Sub_01_MD_C_trafo_Tracts_FA_PASS.mat
Sub_01_MD_C_trafo_Tracts_inter_label_distances.mat
Sub_01_MD_C_trafo_Tracts_L2_EMD.mat

%] Sub_01_MD_C_trafo_Tracts_L2_PASS.mat

%] Sub_01_MD_C_trafo_Tracts_L3_EMD.mat
Sub_01_MD_C _trafo_Tracts_L3_PASS.mat
Sub_01_MD_C_trafo_Tracts_MD_EMND.mat

%] Sub_01_MD_C_trafo_Tracts MD_PASS.mat

Sub_01_MD_C_trafo_Tracts_number_of _tracts END.mat
Suh M BAN © trafn Trarte nommher af tracte DASS mat

Note: to speed up calculations, you could resample the relevant files to a lower resolution (e.g., [2 2 2] mm
instead of [1 1 1] mm results in a speed-up factor of 8!) — before starting the SM/EC/EPI correction step.

Hopefully, you can now manage to get these CMs... So what’s next? Well, now you need another software
tool that allows you to compute the “graph theory” measures and perform group analyses — no need for me
to reinvent the wheel here ;-)! Based on a quick Google search, BCT (http://www.brain-connectivity-
toolbox.net) and GAT (http://ncnl.stanford.edu/tools.html) seem to be good candidates — but don’t quote me
on it... | have not tried these tools myself.

And now... the visuals! Perhaps the most complicated part... and it takes a lot of work, but then again, it may
be worth it (think: cover of journal)! There are many options and different ways to create these connectivity
visualizations (aka: “connectography”), but for now, | will just provide a “quick” example.

Step 1: download the DTl 2mm template (see below) and wait a few seconds (or minutes):

ions | Miscellanea | Debug Desktop Window Help Plugins  Calculate DTI *.mat file

Make figure

Change working directory

Change background color

Show data quality summary

Overlay tract visitation map 4

Fuse CV with FEFA
f with MNI label

[in multi-slice

Surface render mask (30 *.nii}

Download... ICEM DTI 2mm (31 MB)
ICBM DTI1mm (240 MB)

JHU necnate single subject DTI0.6mm (200 ME)

'Connectivity' network

Downloading & unzipping data... please wait.



http://www.brain-connectivity-toolbox.net/
http://www.brain-connectivity-toolbox.net/
http://ncnl.stanford.edu/tools.html
https://twitter.com/Alex_Leemans/status/444423328871505920

Step 2: Load the resulting “ICBM_Mori_DTIl_2mm.mat” file in ExploreDTI (see below):

0 Figures - ExploreDTI v4.8.4 - © Alexander Leemans C:\ExploreDTI\Data\ICBM_Mori_DTI_2mm.mat

==

= |

Data Image map Axis Draw Calculate

Color Show Hide Delete Settings Palettes Animations Miscellanea Debug Desktop Window Help Plugins

ExploreDTIv4.8.4 - © Alexander Leemans C\ExploreDTI\Data\ICEM_Mori_DTI_2mm.mat

Calculate DTl *.mat file ~ |2 x

FER=] =]
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Step 3: “Get label coordinates... > MNI” (see below):

LONCATENTE L 11 ~.Mat TIIES (10 ".All)

Concatenate tract *.mat files (to *.mat)

Generate diffusion gradient directions

Regularize DWIs (4D *.nii)

Tract infe from ether modality

Closing the Venetian blinds

Perform uniform tract resampling

Surmmary uniformly resampled tract *.mat files
Automated FOV cropping of DT *.mat files
Convert... 4
Get diffusion metrics from atlas labels

Gaussian smoothing (*.nii) 4
TV for Gibbs ringing in nen-DWI's (4D *.nii)
MNetwork analysis tools... [

J

Atlas based tractegraphy segmentation
Mask 3D *.nii file...

Select the “atlas labels

” %

.nii and the *.txt “label names” files... Here:

Get 'connectivity' matrices...
Get Label coordinates...

Get Label volumes & surface areas...

[ MNI
ExploreDTI

Create template labels frem MMI coordinates...

Calculate connectivity SNR...

) Select atlas labels (3D *nii)

(€} /.v| <« Local Disk (C:) b ExploreDTI »

.
0 Select label names (fwo column *.tt)

<« Local Disk (C:) » ExploreDTI »

el o

Organize = MNew folder ]

Organize = Mew folder
MName

Mame

Data
s AAL_Labels.nii Data
(4] AAL Template.nii AAL Label Mames.be
and



And save the output as:

° Save label coordinates as ... [&J
bl | <« Local Disk (C:) » ExploreDTI » - |+¢ || Search ExploreDTI 2
COrganize = Mew folder 4= - ﬂ

iz Contacts o Mame
Deskto
= i Data
& Downloads
X | AAL_Label_Mames. bt
i+ Favorites =
# Links
| My Documents
o My Music
= My Pictures
2 My Videos
Roami"g - 4 11 [
e Al abel_coordinates.bd| -
Save as type: |text files (*.txt) - |
# Hide Folders [ Save ] | Cancel |

In this step, the MNI coordinates of the center of gravity of the ROIs were computed:

_|| Label_coordinates.txt - Motepad
File Edit Format View Help
-40 -7 50

40 -9 51

-19 34 41

21 30 43

-18 46 -14

17 47 -15

-34 3z 34

37 32 33

-32 49 -11

32 52 -12

-49 12 18

49 14 20

-47 29 13

449 29 13

-37 30 -13

e

Step 4: Load these “node” coordinates (see below):

(=[5 o)

tiens | Miscellanea | Debug Desktop Window Help Plugins  Calculate DTI*matfile > | 2 X
BOBE &0

Make figure

Change working directory
Change background color
Show data quality summary
Overlay tract visitation map L4
Fuse CV with FEFA
Fuse CV with MNI label

View CV in multi-slice

Surface render mask (30 *.nii)

Download...

'Connectivity' network L Modes Size L4
Edges | Opacity L4
Labels ¥ Color 4
Show ¥ Load coordinates ¥ MNI

Render quality ExploreDTI
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-
0 Select MINI node coordinates (one column * )

@.\ /.vl # Local Disk (C:) » ExploreDTI »

Organize * Mew folder
Mame

Diata
|| AAL_Label_Mames.td

| Label_coordinates.tut

Now, use the “Axis Palette” to uncheck the image planes and “hide the axis”:

ori_DTL_2mm.mat [ i B Figures
- - _ - Data Imagemap Axis Draw Calculate Color Show Hide Data Imagemap Axis Draw Calculate Color Show
tings | Palettes | Animations ~ Miscellanea De e [ -
- Ad |
Aoiis

Draw
PASTA
QA DWIs

M Reverse view [ Cross hairs

QA Volume

R

M XPlane ]

Multi-fiber visualization

Step 5: now, you will actually see nothing, but then click “Show - Nodes” (see below):

=)

Delete  Settings  Palettes  Animations | Miscellanea | Debug Desktop  Window  Help  Plugins  Calculate DTI *.mat file =
Make figure EHE = 0O

Change working directory

Change background color

Show data quality summary
Overlay tract visitation map 4
Fuse CV with FEFA
Fuse CV with MNI label
View CV in multi-slice
Surface render mask (3D *.nii)

Download...

'Connectivity' network ' Nodes *
Edges P
Labels *
Show }

MNodes
Edges

Label Names 4

Surface Rendering *

Also click “Toggle light” to get shading effects (see below):



) Figures

=~

Ng|e O

M Reverse view [l Cross hairs

M XPlane

© Orthographic @ Perspective

® Zoom @® Move HV @ Move FIB

© Orbit @ Orbit Light

Toggle Light

Ais Tools ExploreDTIw4.8.4 - © Alexander Leemans  C:\ExploreDTN\Data\ICBM_Mori_DTI_2mm.mat

Data Imagemap Axs Draw Calculate Color Show Hide Delete Seftings Palettes Animations Miscellanea Debug Deskiop Window Help Plugins Calculate DTI%matfile >

He & 0

You can right-click these “nodes” to change their properties:

Delete this node

Delete all nodes

Set color of this node...
Set opacity of this node...

Set node surface properties...

Step 6: Now let’s change the color, size, and opacity of these nodes (starting with “size”):

s | Miscellanea | Debug Desktop Window Help Plugins  Calculate DTI*.mat file =
Make figure EEEI = |

Change working directory

Change background color
Show data quality summary
Overlay tract visitation map
Fuse CV with FEFA

Fuse CV with MNI label
View CV in multi-slice

Surface render mask (30 *.nii)

Download...

Load coordinates *

Render quality

'Cennectivity' network Nodes ¥ Size } Plot range
Edges ! Opacity } Value range
Labels ¥ Color [ Load file (1 column *.ta file)

The idea is now to select a text file that contains “numbers” reflecting relative size differences.

In this example, | just generated some numbers (N = 90 rows)...
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File Edit

Format View Help

| 28174.
27058.
28915.
32089.

7654.
7859.
38722.
40374.
7112.
8057.
8271.
11174.
20104.
17132.
13590.

F

000
000
000
000
000
000
000
000
000
000
000
000
000
000
000

Now go to “Plot range” and adjust “5” to something

like [1 6] (see below):
L= |

tions | Miscellanea | Debug Desktop Window Help

Make figure

Change working directory
Change background color
Show data guality summary
Owverlay tract visitation map L
Fuse CV with FEFA

Fuse CV with MNI label

View CV in multi-slice
Surface render mask (30 *.nii)
Download...

[

'Connectivity' network MNodes

Edges !

Labels ¥

ro Metwork Analysis .. | =| o= |&r

Set node size (plot range)

C

l OK H Cancel |

Plugins  Calculate DTI *.mat file =

BB & O

==

Size ' Plot range
Opacity ' Value range
Color [ Load file (1 column *.td file)

Load coordinates *

Render quality

ESEETT)

0 Metwork Analysis ..

Set node size (plot range}

14

’ oK H Cancel |
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9

Now “right-click” a node and choose “Delete all nodes” (see below):



Delete this node

Delete all nodes

Set color of this node...
Set opacity of this node...
Set node surface properties...

And then, draw the nodes again (see below) — with the new settings for size, you will see:

|_|:||IE|—

ions | Miscellanea | Debug Desktop Window Help  Plugins  Calculate DTI *.mat file

Make figure EEE et

Change werking directory
Change background color
Show data quality summary
Overlay tract visitation map
Fuse CV with FEFA
Fuse CV with MNI label

View CV in multi-slice
Surface render mask (30 *.nii)
Download...

'Connectivity' network

MNodes »
Edges *
Labels *»
Show

MNodes
Edges

Label Mames 4

Surface Rendering ¥

p. 60
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Similarly, you can adjust the node opacity and color... For opacity, use, for instance, a “plot range” of about
[0.1 1] (“0” is invisible and “1” is fully opaque) with min-max color “Mapping” (see below):

[P
itions | Miscellanea | Debug Desktop Window Help Plugins  Calculate DTI *.mat file
Make figure EEE =

Change working directory
Change background color
Show data quality summary
Owerlay tract visitation map 4
Fuse CV with FEFA

Fuse CV with MNI label

“ Metwork Analysis ... |ﬂld—hj

View CV in multi-slice

Surface render mask (3D *.nii)

Set node opacity (plot range)

0.1
oK | Cancel |

Download... L4

Nodes Size

'Connectivity' network

[ 2
Edges ¥ Opacity r
Labels ¥ Color [ Approach
Show ¥ Load coordinates | Value range
Render quality Colormap ¥

Single color
v Mapping

True indexed colors

You can increase the “Nodes” > “Render quality” to get higher-resolution images (at the cost of slower

interaction):

%

0 Set render directions | =Rl X

Number of render directions (0 -= custom; 1 -= 16; 2 -» 64; 3 =128; 4 -» 255;
5 -» 512, 6 -= 1024; 7 -» 2048; 8 -~ 4096)

4

oK | Cancel |

The result (with “hsv” color map):
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The “Value range” setting is useful for visualizing differences in node (and edge) properties, for instance,
between populations. By defining such a fixed value range, the same “dynamic range” for display will be
chosen. Otherwise, due to the min-max mapping, you accidently may be comparing apples with oranges.
Note that with this setting, you can also perform “value clipping” to get a more “efficient” visualization (e.g.,
think of outliers). Anyway... moving on!

Step 7: Let's add some label names... this was a fun step to script (the nerdy stuff)! Simply “Load Label
names...” and if need be change “Font size & color” (btw, I've quickly set the node opacity back to “1” for
better visibility of all nodes):

|. =Ry A
itions | Miscellanea | Debug Desktop Window Help  Plugins  Calculate DTI *.mat file =
Make figure EE‘ H& O

Change working directory

Change background color
Show data quality surmmary
Overlay tract visitation map 4
Fuse CV with FEFA

Fuse CV with MNI label

View CV in multi-slice

Surface render mask (3D *.nii)

Downlead... ’

'Connectivity' network Modes

Edges
Labels | Load Label names (2 colusin *.tbet file)
Show !} Font size & color

° Select label names (one column *tx

[ « Local Disk (C5) » E

B s

Organize = Mew folder
Name

Data
| AAL Label Mames.bd
| Label_coordinates bt

| Some_property.bd

Now, do the following (click “Two columns”):

=)
mations | Miscellanea | Debug Desktop  Window Help  Plugins  Calculate DTI *.mat file
Make figure EE‘E' |

Change working directory

Change background colar
Show data quality summary
Overlay tract visitation map L4
Fuse CV with FEFA

Fuse CV with MMNI label

View CV in multi-slice

Surface render mask (30 *.nii)

Download... L4
Modes
Edges »
Labels »
Show #

'Connectivity' network

MNodes

Edges
Label Names ' Ring

Surface Rendering ! Twao columns



And the result is:

Frontal M
Frontal M
Frontz

acto
Frontal Inf ( .
oral Pole Mid R
p

Insula
Putamen R
Amygdala R
Pallidt R
Supp Motor Area R
Rolandic er R

Precentral R
iR

julum 3
ParaHippocampal R
Heschl R
Thalamus R
Hippocampus
yoral Sup R
stcentral R
Temporal Inf R

Fusiform R
Cingulum Post R
rietal Inf R

s R

dccipital Inf R

Or if you take the more artistic “Ring” option (btw, use the “Miscellanea” - “Make figure” tool to make high-

res images):

IR
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Step 8: Now, let’'s remove the label names and add some brain context (e.g., left hemisphere — see below):

[ MRS g —

imations | Miscellanea | Debug Desktop Window Help  Plugins  Calculate DTI *.mat file = ~
Make figure EHE 2 O

Change working directory

Change background color
Show data quality summary
Overlay tract visitation map 4
Fuse CV with FEFA

Fuse CV with MNI label

View CV in multi-slice

Surface render mask (30 *.nii)

Download... r

Modes ¥

Edges »
Labels ¥
Show 1

'Connectivity' network

MNodes
Edges
Label Mames g
Surface Rendering ¥ Quality

Colin 27 (MNI)
Colin 27 full (MNI)
ICEM (MNI)
ICEM Left (MNI)
ICEM Right (MNI)

Custom

Delete surface rendering

Set color of surfacg rendering...
Set opacity of surface rendering...
Set surface rendering properties...
Set CV color




Step 9: finally, let's add some “edges”... First define which edges exist:

| | ——

s | Miscellanea | Debug Desktop Window Help  Plugins Calculate DTI *.mat file ¥
Make figure EE =g O

Change working directory

Change background color
Show data quality summary
Overlay tract visitation map L4
Fuse CV with FEFA

Fuse CW with MNI label

View CV in multi-slice

Surface render mask (30 *.nii)

Download... 4

Modes

'Connectivity' network
Edges ! Size L4
Labels ! Opacity L

Show ¥ Color ‘v/
Load binary 'CM" matrix (*.mat file)

Render quality

As an example, I'm picking a result from subject 1 here (just for sake of simplicity):

0 Select binary edge matrix ('CM° matrix *.mat)

Q .=~| € ExploreDTI » Data » Outp
ey

Organize « Mew folder

Mame

temnp_PASS_DTI data_Subj_01_Tracts
temp_PASS_DTI data_Subj_02_Tracts
5 DTLd ata_Subj_01_Tracts_AD_EMD.rmat
5 DTLd ata_Subj_01_Tracts_AD_PASS.mat
DTI_data_Subj_01_Tracts_average_tract_le...
DTI_data_Subj_01_Tracts_average_tract_le...
& DTLd ata_Subj_01_Tracts_binary_EMD.mat
% DTLd ata_Subj_01_Tracts_binary_PAS5.mat
&2 DTLd ata_5Subj_01_Tracts_CL_EMND.mat
&2 DTLd ata_Subj_01_Tracts_CL_PASS.mat

Now, you *could* already show the edges (see below):

SUTIALE TENUET TTAMK 9L .11
Download...
'Connectivity' network Nodes
Edges
Labels
Show Nodes
Edges

Label Names 4

Surface Rendering »
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But likely, it will not be very informative (with default settings — see below):

Right-click to delete all the edges and adjust settings of color/size/opacity — in a similar way as with the
nodes to get something like this:

That's all for now ;-)!
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15. Making animations

The fun stuff ;-)! First, you need to define a set of “axis views”, which will form the basis of the “path” of the
animation. Let’s start off with the first “axis view”, which will then be the start of the animation (see below).

M Reverse view M Cross hairs

XPlane
@ Orthographic @ Perspective

© Zoom @® Move F/B

@ Orbit

Toggle Light

@® Move HV
@ Orbit Light

@® Draw © Delete All

[ moT ] [sEep |

ROI:

ma

Tract shape
Tubes
Sub-sampling

Analyze tracts

Hyper width

CU (Uncertainty) Jd

M Hyper tube mode

Color-encoding
Render quality

Calculate tracts

Transparency

ovase 8

@ Figures |i|ﬂ‘—l-é&-
Data Imagemap Axis Draw Calculate Color Show Hide Delete Settings Palettes  Animations Miscellanea Debug Desktop  Window Help  Plugins  Calculate DTI *.mat file ~
| s O [EnE=R=Nn

Do the following: “Settings > Axis view - Export settings”.

Deletelﬂettingsl Palettes  Animations Miscellanea Debug Deskto

Tractography
HARDI

Glyphs

Image Map
Clustering

Color map

Brain context
Analyze

Axis view

Width ROL/marker
Probability atlas label

Robust estimation

Now save the *.txt file in an empty folder. Here, I've
“C:\ExploreDTI” (see below).

Define settings
Export settings
Load settings

d e W

named it “View_1.txt” and I've put it in the folder



p. 68

‘ Export axis view settings as ... &J
@-u-v| . # Local Disk (C:) » ExploreDTI - |¢?| Search ExploreDT] 2 I
Organize » Mew folder 4= = [@j
MName * Date modified Type Size
Na items match your search.
File name:  View_1.td -
Save as type: | text files (".bd) VI
= Hide Folders [ Save l [ Cancel l
i

Now, we need to define the next “axis view”. So “manipulate” (e.g., zoom in, move, orbit, etc.) the figure (i.e.,
the camera axis settings) to another “axis view”. | rotated and zoomed in to the “axis view” shown below:

® Figures o | B |
Data Imagemap Axic Draw Calculate Color Show Hide Delete Settings Palettes Animations Miscellanea Debug Desktop Window Help Plugine  Calculate DTI* mat file L]
Ndg|le O [EnE=R=N

M Reverse view [M Cross hairs

XPlane
@ Orthographic © Perspective

© Zoom ® Move HIV @ Move FIB
@ Orbit @ Orbit Light

@ Draw © Delete All

(o] o] [ ]

TRACT: Al
Color-encoding Tract shape
Render quality Sub-sampling

-

Calculate tracts Analyze tracts

Transparency Hyper width

e [cunceramy B

M Hyper tube mode

=

Draw Tools Wolume QA tools l ExploreDTIv4.6.4 - © Alexander Leemans C:\Demo_data\Z_[;ata_cm'rectlon\EPI\DTI_MD_C_trafo‘mat |

Save this axis view (just like before: “Settings - Axis view - Export settings”), but now name it “View_2.txt".
The numbering is important, as it will determine the order of the “axis views” in the animation. You can repeat
these steps as many times as you want. As shown below, | saved nine “axis views”.



b B ) |

@le .+ Computer » Local Disk (C:) » ExploreDTI

- | +4 | | Search ExploreDT! 0 |

File Edit
Organize v
Name

|| View 1ot
[ view_2.b¢
1 view 3.0t
[ view 4.0t
|| View 5.6t
|| View 6.0t
|| view 7.0t
[ View 8.6t
|| View 9.0t

View Tools Help

Include in library «

Share with = Burn Mew folder == =

0 @

=

<

1 3

, 9 itemns

———————————————————————————————————————
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In summary, these text files contain “camera settings” that form the “key frames” in the animation. Here’s

what such a file looks like:

,
| View_l.ixt - Notepad

:Eg

File Edit Format View Help

124.02100000 79.31728000 113. 94820000 .
0.00296055 -0.04302720 0.99906951
86.91199453 2.45334303

30. 00000000 30. 00000000

30. 66750000

387.76350000

These numbers correspond with the axis properties as shown in “Settings > Axis view > Define settings”
(see below). Btw, if you want, you can edit these values... think outside the box ;-)!

”
© s view .. o B e

Camera target [x v 2]

124021 7931728 113.9482
'Sky" vector [x v z]
0.0028606 -0.043027 0.99907

Axis [azimuth elevation] (deg)
85,912 245334

Light [azimuth elewvation] (deg}
30 30

Camera ‘perspective’ angle (deg)
306675

Camera distance

387.7635

If you want your animation to loop in a natural “cyclic’ way, then copy the file “View_1.txt” to “View_9.txt”
(that's what | did here... so the last frame of the animation is equal to the first frame).
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The next step is to actually have a look at the animation. To do this, you need to “Load the folder of axis
views” in the “Animations > Axis view paths” menu item (see below).

ilettes Animations|h’|iscellanea Debug Desktop Window Help  Plug

Show frame

Make rotate mowvie

Axis view paths Set number of frames

Set print resclution
Export frames
Load folder of axis views

And...Action!

Here, | have selected this folder: “C:\ExploreDTI”". Then, just click “And... Action!” in the “Animations > Axis
view paths” menu item (see below):

es | Animations | Miscellanea Debug Desktop  Window  Help

Show frame

Make rotate movie

Axis view paths Set number of frames
Set print resclution

Export frames

Load folder of axis views
And...Action!

ective

Move F/IB

—
uni EITOrs may occu r! .

At this stage, you’re simply “checking” your animation... If you are happy with the “path” of animation, then
you can adjust the “number of frames” (the temporal resolution). Also the spatial resolution can be adjusted
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(think “full HD” or even “4K” resolution of the frames). My suggestion, start with low values of “number of
frames” (e.g., 100) and “print resolution” (e.g., 100) for sake of efficiency and then increase these values to
whatever you want. The final step is to create all the frames (the “computational expensive” part). So define
an output folder (click “Export frames”):

Palettes | Animations | Miscellanea Debug Desktop  Window Help

Show frame

Make rotate movie

Axis view paths Set number of frames

Set print resolution
Export frames
Load folder of axis views

And...Action!

| created a new subfolder “Frames” (see below) and selected that one.

o
o Select the folder to export the frames... I&J
@.u.v| <« Local Disk (C:) » ExploreDTI » - | +3 |[ search ExploreDT! jel
Organize « Mew folder == - ﬂ
&
Name

Frames

4 I 3

Folder: Frames

Select Folder ] | Cancel

Notice that “Export frames” is now “checked”...

‘alettes | Animations | Miscellanea Debug Desktop Window Help  Plugins

Show frarme

Make rotate movie

Axis view paths Set number of frames

Set print resolution
Export frames
Load folder of axis views

And...Action!

If you click “And...Action!” now (while “Export frames” is “checked”), it will export the frames of your
animation to that folder. Note that printing a single frame may take a few seconds (depending on the object
rendering and the “print resolution”).
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If you made the animation with, for instance, 100 frames, the folder will contain 100 images (“png” format —
see below).

[ B

@vv‘ » Computer » Local Disk (C:) » ExploreDTI » Frames v|4,H Search Frames 5

File Edit View Tools Help
Organize v Include in library v Share with v Slide show Burn New folder =+ [0 @

m

Frame_005.png

Frame_016.png

Frame_017.png Frame_019.png

Frame_026.png Frame_027.png

m

Frame_022.png Frame_028.png

\ 100 items
f

Frame_023.png Frame_024.png

-
W\

\

The last step is now to create a movie from all these “frames”. There are many (free) tools out there to do
this... Here’s one: “VirtualDub” (http://www.virtualdub.org).

As an example, | ran the animation with 1080 frames and 240 dpi resolution. | used 27 frames per second
and cropped the size to 1920 by 1080 (HD) resolution...

The result can be seen here: http://youtu.be/X4HSHE4S6ng



http://www.virtualdub.org/
http://youtu.be/X4HSHE4S6ng
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16. Automated / atlas based ROI analysis

There are two ways to do this:

[

nations  Miscellanea Debug Desktop Window Help | Plugins | Calculate DTI*.matfile =~ | @& X|

Correct for subject motion & EC/EPI distortions
Whole brain tractography L4
3D *.nii 2 3D *.nii

Export stuff to *.nii files

Flip left-right crientation of DTI *.mat file
Generate synthetic diffusion MRI data L4
Resample 3D/4D *.nii file(s)

Flip/permute dimension(s) of 30/4D *.nii file(s)
Shuffle/select 30 velume(s) in 4D *.nii file(s)

Sort DWI *.nii file(s) wrt b-values

Get precisions (wild bootstrap) of DTI *.mat

Check motion/distortion correction

Check outlier profiles

Open 'MRIcroM' (€ Chris Rorden)

Crop size of *.nii file

Concatenate DTI *.mat files (to *.nii)

Concatenate tract *.mat files (to *.mat)

Generate diffusion gradient directions

Regularize DWIs (4D *.nii)

Tract info frem other modality

Closing the Venetian blinds

Perform uniform tract resampling
Summary unifermly resampled tract *.mat files

Automated FOV cropping of DTI *.mat files

Convert...
Get diffusion metrics from... Atlas labels
Gaussian smoothing (*.nii) } ROIs in native space

TV for Gibbs ringing in non-DWI's (4D *.nii)

The top one (‘Atlas labels’) has been used, for instance, in “Kersbergen KJ et al, Neurolmage, 2014” and
uses an atlas template, its labels (i.e. the ROIs), the label names, and the DTI *.mat file(s) as input. In short,
by warping the atlas template (and transforming the associated labels) to each individual data set, diffusion
metrics are calculated in each ROI. Here’s how it works:

Assume you have the following input data set (“Subject_1.mat” is the DTI file; the other three files are the
template files... you can find them in folder ~\ExploreDTI\Source\Templates):

=~ 0 @

i Narne

s 5RI24_Template.nii
| SRI24_tzollbplus_Label_Mames.txt
8| SRI24_tzoll6plus_Labels.nii

Subject_1.mat

Then choose what applies for your data:

° Diffusion metrics fro... |£|_|éj

@ Single or multiple data sets?

| f.1u|ti|:-le|



http://www.ncbi.nlm.nih.gov/pubmed/25261000
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Here, I'll choose “Multiple”... | select my “Input” folder which has the DTI files in it:

= T 3

Folder: Input

Select Folder l | Cancel
Then, select the output folder:
- 4 I 3
Folder: Output
[ Select Folder ] | Cancel |

Then, select the atlas labels (screenshot below included simply for illustration purpose):

File Edit Overlay Draw View Window Help

Wl 2y 2z e 2 mit -|§|

Backaround -|§|wmsa < 53 = -‘EHE‘

(00x1 = 0.00000

| SRI24_Template.nii
¥ SRI24_tzol16plus_Labels.nii

m

- 4 m F

File name: SRI24_tzoll6plus_Labels.nii - (*.nii) v|

[ Open ] | Cancel |

Then, select the atlas template:

MName

File Edit Owverlay Draw View Window Help
e S T T X Sez0 2z 2 wit - | & |
%] 5R124_tzoll6plus_Labels.nii (. ]

Backgrourd .|.j9‘ 00976 = 05154 =) Grayscale v|3:;H.:;|

< [ b

File name: SRI24_Template.nii - |(".nii) vl

s

Intenasity range 0.0976..0 5154




And finally, the label names:

MName

| SRI24 tzoll6plus_Label MNames.bd

4 I

File name: SRI24_tzoll6plus_Label Namestbd - I(*-bd:) 'I

[ open | [ cance |
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Note that you can choose your labels by setting “1” in the first column... “0” values indicate that you will not

include that ROl/label in the analysis (FYI, only a part of the file content is shown below):

-

j SRI24_tzoll6plus_Label_Mames.txt - Notepad

File Edit Format View Help

Pallidum_r
Pallidum_L
Thalamus_R
Thalamus_L

Heschl_R

Heschl_L
Temporal_Sup_R
Temporal _Su?_L
Temporal_Pole_Sup_R
Temporal_Pole_sup_L
Temporal_Mid_R
Temporal _Mid_L
Temporal_pole_Mid_Rr
Temporal_Pole_Mid_L
Temporal_Inf_R
Temporal_Inf_L
Cerebelum_Crusl_R
Cerebelum_crusl_L
Cerebelum_Crus2_Rr
Cerebelum_Crus2_L
cerebelum_3_Rr
Cerebelum_3_L
Cerebelum_4_5_R
Cerebelum_4_5_L
Cerebelum_6_R
Cerebelum_6_L
cerebelum_7b_RrR
Cerebelum_7b_L
Cerebelum_8_R
Cerebelum_8_L
Cerebelum_9_R
Cerebelum_9_L
Cerebelum_10_R
Cerebelum_10_L
Vermis_1_2

vermis_3

vermis_4_5

vermis_6

vermis_7

vermis_8

vermis_9

vermis_10
Lateral_ventricle_R
Lateral_ventricle_L
Third_ventricle_Rr
Third_ventricle_L
Corpus_callosum_apr_0
Corpus_Callosum_aP_1
Corpus_Callosum_AP_2
cCorpus_callosum_apr_3

o PHFPFHFOOOOOOOCOOO0O000 000000000000 0000000000000 00O OoOHFHFOO

And then wait a few minutes (up to a few hours depending on data size and number of atlas labels)

) Do not close waitbar: unexpected errors may occur! EI_‘*J

Waitbar
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The output looks like this (the *.nii files are for quality control):

=R

| Average 2nd eigenvalue (in10*-3 mm*2 s*-1}.bd | DTLmetrics_from_atlas_labels.bd
|| Average 3rd eigenvalue (in 10"-3 mm”2 s"-1).bdt | 5D 2nd eigenvalue (in 10*-3 mm*2 s*-1).bdt

| Average AD (in10*-3 mm*2 s*-1).bt |50 3rd eigenvalue (in 10°-3 mm*2 s*-1).bt
| Awverage axial kurtosis.bet | |SDAD (in104-3 mm "2 s™-1)bet
|| Average CL.bd || 5D axial kurtosis.be

| Awverage CP.bet |50 Clbd

| Average Ch.bit | |SD CPbt

|| Average FA.bd || 5D CS.bd

| Awverage kurtosis anisotropy.bd | |SDFAbLE

| Average MD (in 10*-3 mm*2 s*-1).bet || 5D kurtosis anisotropy.bd

|| Average mean kurtosis.bd |50 MD (in 10*-3 mm*2 s"-1).txt
| Average radial kurtosis.bt |50 mean kurtosis.bd

| Average RD (in 10"-3 mm*2 s*-1) bt || 5D radial kurtosis.bd

=) Corpus_Callosum_AP_0_Subject_1.nii __|SDRD (in10*-3 mm*2 s*-1).et
) Corpus_Callosum_AP_1_Subject_1.nii || Subject_1_ternplate.nii

|| Corpus_Callosum_AP_2_Subject_1.nii || Thalamus_L_Subject_1.nii

=) Corpus_Callosum_AP_3_Subject_1.nii || Thalamus_R_Subject_1.nii

) Corpus_Callosum_AP_4_Subject_1.nii | Veolume (in mm*3).bt

\#| Corpus_Callosum_AP_5_Subject_1.nii
) Corpus_Callosum_AP_6_Subject_1.nii
| Corpus_Callosum_AP_7_Subject_1.nii
=) Corpus_Callosum_AP_8_Subject_1.nii

As an example, I'll open the “Average FA.txt” file in Excel:

o - =
A B C D E F G

1 Thalamus_R Thalamus_L Corpus_Callosum_AP_0 Corpus_Callosum_AP_1 Corpus_Callosum_AP_2 Corpus_Callosum_AP_3 Cor

2 Subject_1 0.34982246 0.33281156 0.47112158 0.65627211 0.58885288 0.53871077

3

4

H | 1 K L
pus_Callosum_AP_4 Corpus_Callosum_AP_5 Corpus_Callosum_AP_6 Corpus_Callosum_AP_7 Corpus_Callosum_AP_8
0.60971931 0.38315009 0.61916775 0.68645954 0.81332505

If you had more subject data sets, then the file above would have had more rows... That's it!

Now let’s look at the other option (‘ROls in native space’):

FETOrmM unitorm tract resampling
Summary uniformly resampled tract *.mat files

Autornated FOV cropping of DTI *.mat files

Convert... L
Get diffusion metrics from... ! Atlas labels
Gaussian smoothing (*.nii) ' ROIs in native space

TV for Gibbs ringing in non-DWI's (4D *.nii)
MNetwork analysis tools... 4
Atlas based tractography segmentation

= Mask 3D *.nii file...

In this case, we assume that the ROIs are already in the same space of the diffusion data. The format of the
ROls is as usual: a 3D *.nii file with “0” values reflecting the background and values 1, 2, 3, etc. representing
ROI 1, ROI 2, ROI 3, etc. The *.txt file with label names corresponds to the ROIs where the row number
denotes the ROl number (see below).
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"] Sub_01_MD_C trafo_label_namestxt - Notepad (200 [E0- e S Edit Overlay Draw View Window Help

File Edit Format View Help 120 Sy 111 22121 5 wfit - &
Left-Cerebral-white-Matter -

Left-Lateral-ventricle Backgound .ja 10000 2 137.0000 = Grapscele

Left-Cerebel lum-white-Matter
Left-Cerebellum-Cortex
Left-Thalamus-Proper
Left-Caudate

Left-Putamen

Left-Pallidum

3rd-ventricle
4th-ventricle

Brain-stem
Left-Hippocampus
Left-amygdala

CSF

Left-Accumbens-area
Left-ventraloc

Left-vessel
Left-choroid-plexus
rRight-Cerebral-white-mMatter
right-Lateral-ventricle
Right-Inf-Lat-vent
Right-Cerebellum-white-Matter
2 W | s =R o 0 (=4

Right-Thalamus-Proper

Right-Putamen
right-Pallidum
Right-Hippocampus
rRight-amygdala
Right-Accumbens-area
rRight-ventraloc

m

CHOOFROoOOFROFRPHROOREHEROROoOR

Row 25

oFEREEE

As usual, “0” values in the *.txt file mean that these ROls are not considered for analysis.

The input typically looks something like (here, folder name was “ROI_analysis” — see later):

it MName

%) Sub_01_MD_C trafo.mat

| Sub_01_MD_C_trafo_label_names.tt
| Sub 01_MD_C_trafo_labels.nii

|| Sub_01_MD_C_trafo_Tl.ni

“Sub_01_MD_C trafo.mat” is the DTI file. Note that it was transformed to the T1l-weighted image, i.e.
“Sub_01_MD_C_trafo_T1.nii", during SM/EC/EPI distortion correction. “Sub_01_MD_C_trafo_labels.nii” has
the labels and “Sub_01_MD_C_trafo_label_names.txt” the corresponding label names:

OK — let’s run the ‘ROls in native space’ tool ... First, select the input folder of DTI *.mat files:

4 T

der:  ROLanalysis

Select Folder l | Canai
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Then fill in the suffix parts corresponding to the labels/ROI *.nii file and label names *.txt file:

i B
° Diffusion metrics from ROIs in native space... lilﬂlg

Extension name for ROIs *nii files
_labels.nii

Extension name for label * txt files
_label_names.bxt

Finally, select an output folder:

1 1

der  Output_ROIL_analysis

[ Select Folder i [ Cancel

Typically, this only takes a few minutes... The output looks like:

Output_ROL analysis - | +5 | | Search Output RO analysis ye |
- 0 e
|| Average 2nd eigenvalue (in10*-3 mm*2 s*-1).bt || Average RD (in10"-3 mm*"2 s"-1).bdt
|| Average 3rd eigenvalue (in 10*-3 mm*2 s-1).bct || 5D 2nd eigenvalue (in 10-3 mm*2 s*-1).bt
| Average AD (in104-3 mm "2 s*-1) bt | 5D 3rd eigenvalue (in 107-3 mm "2 s*-1).tt
|| Average axial kurtosis.bd . |SDAD (in10"-3 mm*~2 s"-1)bet
|| Average CL.bxet | SD axal kurtosis.bdt
|| Average CP.bdt | SD Clixt
|| Average C5.bt =] 5D CP.t
|| Average FAbt || SD CS5.bet
|| Average kurtosis anisotropy.bed | SD FAbt
|| Average MD (in 10*-3 mm*2 s"-1).bt || SD kurtosis anisotropy.tt
|| Average mean kurtosis.bt |SDMD (in10"-3 mm"2 s"-1).bxet
|| Average radial kurtosis.tet || 5D mean kurtosis.td
14 1 ] 3

If we open for instance “Average FA.txt” in Excel, we get:

lppoara la ront la Allgnment la numper la
| Q38 - £ |
I A B = D E F G H I il
1 File name 3rd-ventricle 4th-ventricle brain-stem cc_anterior cc_central cc_mid_anterior cc_mid_posterior cc_posterior csf
2 Sub_01_MD_C_trafo N/A N/A 0.35502919 0.60191505 0.41827561 0.37418305 0.36821181 0.58660962 N/A

3

Again, each row represents a subject’s data set. The “N/A” indicates that for that ROI, there was a “0” value
in the label names *.txt file.

That'’s it!
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17. Along-tract analysis

For research papers where this kind of analysis has been used, see for instance O’'Hanlon E. et al, JAMA
Psychiatry 2015, Szczepankiewicz F. et al, Neurolmage 2013, and Reijmer Y.D. et al, Stroke 2013. The
methodological details are based on Colby J.B. et al, Neurolmage 2012.

In summary, the idea is to investigate properties of a fiber bundle along its trajectory instead of averaging
these properties across its entire path length. The following figure (adjusted from Perrone D. et al,
Neurolmage 2015) should clarify this concept. As an example, ‘K’ points along a mid-sagittal segment of the
forceps minor are compared (e.g., with a t-test) between ‘M’ healthy controls and ‘N’ patients.

Subject 1 .‘.‘.....‘
*

*
Q’.‘Q 0’

¢ TSR

Subject 2

L
.Q 0000‘
*0

Subject N

t-test for
each point

Subject 1
—>

Subject 1

Diffusion measure

p— O~
’/0 ’\0~Q" "“Q-

Subject 2

L 2 —
\‘~0/‘ “0\‘,

—
Subject 2
0\‘\’ P
== —p_o—"
Subject M
—
Subject M
Position along tract
(# points = K)

Some considerations... First, for each subject a fiber bundle (segment) needs to be computed. This can, for
instance, be achieved with the tool described in Section 13 (or simply manually on a subject-per-subject
basis). My personal preference is to use a specific “segment” to make sure the “endings” of a fiber tract are
defined in a better way (see below):

Entire fiber bundle > with “segment ROIs” > Segment only


http://www.ncbi.nlm.nih.gov/pubmed/25923212
http://www.ncbi.nlm.nih.gov/pubmed/25923212
http://www.ncbi.nlm.nih.gov/pubmed/23507377
http://www.ncbi.nlm.nih.gov/pubmed/23686971
http://www.ncbi.nlm.nih.gov/pubmed/22094644
http://www.ncbi.nlm.nih.gov/pubmed/26142273
http://www.ncbi.nlm.nih.gov/pubmed/26142273
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Second, the fiber bundles need to be resampled with a predefined number of points (i.e., “K” — as in the
figure above), which should be same for each subject (to ensure correspondence). A reasonable value for
“K” is to divide the average (across subjects) tract length of the fiber bundle of interest by the length scale of
the voxel size. For example, if the voxel size is 2 x 2 x 2 mm? and the average length of the reconstructed
uncinate fasciculus segments approximately equal to 70 mm, then K = 70/2 = 35 points should be fine.
Taking more points will not add any new information and by sampling fewer points, you may miss
information.

The input for the ExploreDTI tool consists of the tract (segment) *.mat files — all together in a single folder:

m

Subj_01_UNC_L.mat
Subj_01_UNC_R.mat
Subj_02_UNC_L.mat
Subj_02_UNC_R.mat
Subj_03_UNC_L.mat
Subj_03_UNC_R.mat
Subj_04_UNC_L.mat
Subj_04_UNC_R.mat
Subj_05_UNC_L.mat

) Subj_06_UNC_R.mat
) Subj_07_UNC_L.mat
) Subj_07_UNC_R.mat
| Subj_08_UNC_L.mat
) Subj_08_UNC_R.mat
") Subj_09_UNC_L.mat
| Subj_09_UNC_R.mat
) Subj_10_UNC_L.mat
) Subj_10_UNC_R.mat

) Subj_05_UNC_R.mat
« % 5ubj_06_UNC_Lmat

For this toy example, the idea is now to compare diffusion properties between the left and the right uncinate
fasciculi for 10 subjects.

Step 1: Resample all the tract files with “K = 35” points. Go to ‘Plugins’ - ‘Perform uniform...’

/

Summary uniformly resampled tract *.mat files

Tract info from other modality
Closing the Venetian blinds

Perform uniform tract resampling

U I N T W S SR L' g E S

-

El |5

0 Uniform tract resampling .. U=

MNumber of tract samples (integer > 1)

35

Then choose multiple data and select the folder of the tract *.mat files:

-
o Uniform tract resamp... EI_Iﬂ—hj

@ Single or multiple data sets?

el

L | m k

Folder: Tracts

Select Folder ] [ Cancel
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Save the uniformly resampled (UR) tracts in an output folder (here: “UR _tracts”):

<

LI}

der: UR_tracts

[ Select Folder ] ’ Cancel ]

Subj 01_UNC_L_ur.mat
Subj_01_UNC_R_ur.mat
Subj_02_UNC_L_ur.mat
Subj_02_UNC_R_ur.mat
Subj 03_UNC_L_ur.mat
Subj_03_UNC_R_ur.mat
Subj_04_UNC_L_ur.mat
Subj_04_UMNC_R_ur.mat
Subj_05_UNC_L_ur.mat
Subj_05_UNC_R_ur.mat

Subj_06_UNC_L_ur.mat
Subj_06_UNC_R_ur.mat
Subj_07_UNC_L_ur.mat
Subj_07_UMNC_R_ur.mat
Subj 08_UNC_L_ur.mat
Subj_08_UNC_R_ur.mat
Subj_09_UMNC_L_ur.mat
Subj_09_UMNC_R_ur.mat
Subj 10_UNC_L_ur.mat
Subj 10_UNC_R_ur.mat

The output of this step is simply another set of tract *.mat files and can be used/visualized as any other tract
*.mat file (notice the suffix “_ur” being added):

Step 2: for each tract *.mat file, the fiber bundle (set of trajectories) will be reduced to a single “averaged”
pathway. This is achieved with the plugin:

R s T s iy
Closing the Venetian blinds

Perform uniform tract resampling

Surnmary uniformly resampled tract *.mat files
Autornated FOV cropping of DTI *.mat files

Convert... 4

Select that folder of UR tract *.mat files:

Select Folder Ci

Folder: UR_tracts

Save the summary of the UR tract *.mat files in some output folder (e.g., summary_tracts):

Folder: summary_tracts

Select Folder

Then use “mean” or “median” to do the averaging of the diffusion metrics (I only included the option to check
whether it would make a difference... well, it appears it doesn’t — so simply take the mean):

(=] s

P
‘ Summarizing tract informaticn...

Choose type of tract information reduction

| rne; | [meclian I




The end result looks like:

AD bt

FAbt

MD bt

RD.bet

Subj 01_UNC_L ur_rimat %
Subj 01_UNC R_ur_rimat %
Subj_02_UNC_L_ur_rimat %
Subj 02_UNC R_ur_rimat %
Subj 03_UNC_L ur_rimat %
Subj 03_UNC R_ur_rimat %
Subj_04_UNC_L_ur_rimat
Subj_04_UNC_R_ur_ri.mat
Subj_05_UNC_L_ur_ri.mat

%) Subj_06_UMNC_L_ur_ri.mat
%) Subj_06_UNC_R_ur_ri.mat
%) Subj_07_UNC_L_ur_ri.mat
%) Subj_07_UNC_R_ur_ri.mat

%

[t
Czod

Subj_05_UNC_R_ur_ri.mat

Subj_08_UMNC_L_ur_ri.mat
Subj_08_UMC_R_ur_ri.mat
Subj_09_UNC_L_ur_ri.mat
Subj_09_UMC_R_ur_ri.mat
Subj_ 10_UMNC_L_ur_ri.mat
Subj_10_UMC_R_ur_ri.mat
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Now, each tract *.mat file simply consists of a single trajectory. After making sure that the endings of the
pathways correspond between the subjects (and left/right sides), the figure below shows the 10 left and 10
right tracts with color-encoding reflecting this correspondence across subjects/sides:

Top view

Frontal view

The *.txt files contain the diffusion measures (or world coordinates) along the pathways (columns) for each
data set (rows). For instance, for the FA:

W0 s B W e

S HEREAEREEREE
[ R R T Bw (RS

A
Subj_01_UNC_L_ur
Subj_01_UNC_R_ur
Subj_02_UNC_L_ur
Subj 02 UNC R ur
Subj_03_UNC_L_ur
Subj 03 UNC R ur
Subj_04_UMC_L_ur
Subj_ 04 UNC_R_ur
Subj_05_UNC_L_ur
Subj_05_UNC_R_ur
Subj_06_UNC_L_ur
Subj_06_UNC_R_ur
Subj_07_UNC_L_ur
Subj_07_UNC_R_ur
Subj 08 UNC L ur
Subj_08_UNC_R_ur
Subj_09_UNC_L_ur
Subj_09_UNC_R_ur
Subj_10_UNC_L_ur
Subj_10_UNC_R_ur

B

0.1978476
0.11055504
0.20158867

0.1765241
0.15127484
0.19147925

0.1505824
0.17405451
0.13664559
0.11808045
0.16642318
0.21171651
0.15631274
0.13472333
0.22718161
0.21355266
0.23606514
0.16175105

0.1628739
0.21180424

C
0.22410513
0.15978238
0.19965639
0.19477864
0.17575671
0.17908318
0.17127414

0.2097058
0.15025762
0.15467317
0.15367524
0.19861543
0.18008358
0.14371859
0.24060717
0.22388502
0.23613196

0.1993354
0.17451604

0.2181099

0.2455098
0.23502203
0.23552328
0.22247859
0.20828917
0.23166281

0.1837973
0.24863955
0.21736874
0.18753063
0.16371438
0.20237374
0.21962814
0.17163569
0.28001925
0.25435338
0.24934666
0.23409755
0.23039423
0.24345584

D E

0.27902072
0.23698129
0.29726335
0.26083997
0.23658924
0.27437564
0.20057766
0.24997392
0.24450603
0.20965887
0.16622704
0.24363264
0.25606323
0.21561202
0.32101761
0.28713744
0.27026541
0.26175589
0.25174576
0.29529049

F G
0.30362992 0.29933797
0.26954632 0.24962346
0.34429403 0.34226217
0.30781773 0.33403664
0.29802598 0.35943015
0.25862883 0.24843832
0.24413764 0.28880355
0.27101473 0.26741215
0.27221143 0.26830379
0.23808695 0.25501636
0.19131964 0.24309958
0.23383232 0.24241234

0.2919215 0.30409192
0.24857433 0.27465067
0.33841739 0.35196553
0.32507106 0.35151734
0.31566818 0.35292476
0.25954058 0.23257936
0.27804873 0.32202658
0.33967236 0.35978288

H
0.30122764
0.23676009

0.3506436
0.33748694
0.35779146
0.26600498
0.30610703
0.27704688
0.28086123
0.26953916
0.29620403
0.26165646

0.3179618
0.28772675
0.35207963
0.36047656
0.36597455
0.23484776
0.34790743
0.34684397

0.30527367
0.25822502

0.3589523
0.323021006

0.3439793
0.29443066
0.30908539
0.29827911
0.28896291
0.26650675
0.28209809
0.26316012
0.33296327

0.2381444
0.35601877
0.35025877
0.38389892
0.27780853
0.35836527
0.33096345

I 1
0.31157305
0.28972203
0.37873391
0.35423194
0.36541418
0.33786838
0.31823764
0.31022659
0.30132772
0.2678526
0.26062938
0.26830235
0.35105555
0.28266783
0.36165745
0.35200782
0.41378311
0.29362327
0.3746804
0.34154448

K

0.34083669

0.3209552
0.40932734
0.37576671
0.40783358
0.37346705
0.33898552
0.32790035
0.33091689
0.30538511
0.25497078
0.29336377
0.37207939
0.29386919
0.35485697

0.3595545

0.4327728
0.30860555
0.40557555
0.35541155

L

0.3560173
0.34120971
0.40323674
0.36522666
0.42191544
0.38445964
0.36140458
0.34713296
0.37051946
0.35020435
0.25091611
0.31923043
0.37981124
0.30111358
0.34946282
0.35920834
0.44255176
0.32880112
0.41904306
0.36118051

M

0.3678282;

0.352996!
0.4032865!
0.3652608!
0.4155703
0.4054504;
0.3859752:
0.32666902

0.383306!
0.3739258i

0.258653:
0.3291594!

0.374865.
0.2933688"
0.3566723
0.3707059:
0.4503983;
0.3403587
0.4035664!

0.391724:

Or when plotting the left (blue) versus the right (red) side FA values (error bars are simply the standard
deviation across subjects):
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Position

While there are some significant (uncorrected p<0.05) differences (lowest p-value was roughly 0.003 — see
below), one may argue that a correction factor of 35 (Bonferroni — number of t-tests) needs to be included...
No significant difference then for any point along the tract.

1 T T T T T T T
0r i
Logio
(p-value) -1 .
2t 4
_3 1 1 1 1 1 1 1
0 5 10 15 20 25 30 35

Position

Using the corresponding “X” (front-back), “Y” (left-right), and “Z” (bottom-top) coordinate *.txt files, it’s trivial
to understand what is the beginning/ending of the plot (for instance for the uncinate fasciculus, the temporal
pole has typically lower values of the z-coordinates than the orbitofrontal part).

That's all for now!



